IBM WebSphere Application Server - Express Versao 5.1

Guia de Migracao

<|ll



Nota!
Antes de utilizar estas informacdes e o produto suportado por elas, certifique-se de ler
as informacgoes gerais nos |“Avisos” na pagina 63|

Sexta Edicao (Dezembro de 2003)

© Copyright International Business Machines Corporation 2000, 2003. Todos os direitos reservados.



Indice

Capitulo 1. Visao Geral do Guia de
Migracao do WebSphere Appllcatlon
Server - Express . . . . e a1

Capitulo 2. Migrando o Servidor de

Producao . . 3
Migragao .3
Migrando e Coex1st1nd0 .4
Ferramentas de Migracao . .5
Comando WASPreUpgrade .5
Comando WASPostUpgrade . . . .6
Mapeamento de Configuragdo durante a Mlgragao .8
Migrando Dados de Configuracdo Manualmente . 10
Migrando da V3.5.x paraa V5.1 . . . .1
Migrando a V3.5.x para uma Médquina V5.1 Remota 13
Migrando da V5.0.x paraa V5.1 . . . .15
Migrando da Maquina V5.0.x para uma Maquma
V5.1 Remota . . . . . . .15
Migrando de um Slstema Operac1onal
Nao-Suportado . . . . . . . . . . . . .17
Capitulo 3. Migrando do IBM
WebSphere Studio Site Developer
Versao 5.1 . . . . . e b
Migrando Projetos J2EE para Utlhzar o Suporte do
Server Targeting. . . . 19

Compatibilidade Reversa com o Suporte Atlvado

do Server Targeting. . . . .19
A Geragdo do Assistente Requer um Pacote ]ava
paraJDK1.4 . . . . . . . . . . . . . .2

Capitulo 4. Migrando do IBM

WebSphere Studio Site Developer

Versao 5 ou Versao 5.0.1. . . . . . . 21
WebSphere Studio Workbench na Versao 5, na

Versdo 5.0.1 e na Versdo 5.1 . . .21
Utilizando o Espago de Trabalho do IBM WebSphere
Studio Site Developer Versao 5.1.1 com a Versao 5.0. 21
Migrando Projetos Java da Versdo 5 ou da Versao

501. . . . .. 22
Compartilhando Pro]etos entre a Versao 5 ou a

Versao 5.0.1 e a Versdo 5.1.1 Utilizando um Sistema

SCM (Source Code Management) . . . . . . .22
Migrando Projetos da Web . . . .. 24
Convertendo Projetos da Web para o Struts 1. 1 .. 24
Alteragoes nas Ferramentas de Servigos da Web . . 25
Alteragoes Feitas nas Ferramentas de Criagao de

Perfil . . . . .25
Problemas Conhecrdos de Compatrbrhdade do
Assistente para Gabarito . . . . . . . . . .26

© Copyright IBM Corp. 2000, 2003

Capitulo 5. Migrando do IBM
WebSphere Studio Site Developer

Versao 4.0.x . . . . . .27
Diferencas entre IBM WebSphere Studlo Slte
Developer Versdo 4.0.x e Versao 5 . . .27
Alteragdes do WebSphere Application Server e
Ferramentas de Conversao do Servlet/JSP . . . .28
Alteragoes Internas da Versao 403 . . . . . .28
As Dependéncias de Projetos Circulares Nao
Serdo Compiladas por Padrdao . . . . . . .28

Os Projetos da Web da Versao 5 Sao de
Localizacdo de Origem Compativel com a Versao

403. . . . ... 029
Estruturas de Pro]etos da Web do IBM
WebSphere Studio Site Developer . . . . . .29
Projetos da Web Estéticos versus Dindmicos . . 29
Distingdes entre HTML e JSP . . . . .30
Migrando Projetos Utilizando um Sistema SCM
(Software Configuration Management) . . . 30
Migrando Projetos Utilizando CVS ou Ratlonal
ClearCase . . . .. .30

Remogao Pos—mrgragao das Referenc1as de
Caminho Absoluto do EAR e do Servidor de
Configuragao. . . .. 32
Migrando Projetos Utlhzando Outros SCMs .32
Migrando os Projetos por Exportacdo e Migracdo. . 32
Migrando Projetos Utilizando um Espago de
Trabalho Existente da Versdao 4.0x. . . . . . .33
Remogao Pés-migragdo das Referéncias de
Caminho Absoluto do EAR e do Servidor de

Configuragdo. . . P )
Problemas e L1m1tagoes Conhec1dos ... . .34
Migrando Dados Relacionais nos Pro]etos da Web
de4.03. . . . . 35
Erros WSDL Apos a Importagao de um Arqulvo
de Servicos da Web de 4.0.x . . . . .35
Migrando Estruturas de Projetos do ]2EE e / ou
Niveis de Especificacdfo doJ2EE . . . . . . .35

Capitulo 6. Migrando do WebSphere
Studio "Classic” para o IBM
WebSphere Studio Site Developer. . . 37

Criando uma Nova Etapa de Servidor Unico para

Migracdo . . . . 38
Criando um Arqulvo Descrrtor de Confrguragao da
Web . ... .38
Exportando um Arquivo ]AR de Migragéo ... .38
Importando o Arquivo JAR de Migragao para o IBM
WebSphere Studio Site Developer . . . . 38
Testando o Aplicativo Migrado em um Serv1dor de
Teste. . . . . . . . . . . . . . . . .3
iii



Capitulo 7. Migrando do VisualAge
para Java para o IBM WebSphere

Studio Site Developer . . . . .. 4

Diferencas entre VisualAge para Java e IBM

WebSphere Studio Site Developer . . . . . . .41

Migrando do VisualAge para Java. . . . . 42
Exportando seus Arquivos Java e Arquivos de
Recursos do Projeto do VisualAge para Java . . 42

Iniciando o IBM WebSphere Studio Site

Developer e Criando Novos Projetos para Conter

o Cédigo . . . . .43
Importando os Arqulvos ]ava e Arqulvos de
Recursos para o IBM WebSphere Studio Site
Developer . . . . 43
Utilizando o Editor web xml para Assegurar que

os Servlets Estao Definidos Corretamente

(Somente Projeto da Web) . . . . . .43
Migrando Defini¢des de Projeto e Espago de
Trabalho . . . L. 44

Configurando o Amblente de Teste do

WebSphere V4 e Testando o(s) Aplicativo(s)
Migrados(s) . . . 45
Implementando Aphcatlvos do IBM WebSphere
Studio Site Developer para o WebSphere

Application Server Remoto . . . . .45
Compartilhando as Defini¢oes de Pro]etos do

IBM WebSphere Studio Site Developer entre

Varios Desenvolvedores (Migracdo Posterior) . . 46
Suporte de Equipe no IBM WebSphere Studio Site
Developer . . . . 0

Capitulo 8. Migrando do VisualAge

para Java Visual Composition Editor

para o Visual Editor paraJava . . . . 47
Salvando Metadados de Tempo de Design

Aprimorado do VisualAge paraJava. . . . . .47
Concluindo a Migracdo (Importando para o
WebSphere Studio) . . . . . . . . . . . .48

Capitulo 9. Configuracao da

Compilacao (Biblioteca, JARs, JARs
Dependentes de Projeto, Compilacoes
Ant) . C e e . 49
JARs da Blbhoteca Java e ]ARS Externos de Tercelros 49

A Maneira Recomendada de Utilizar um JAR de

Terceiros em um Projeto da Web . 49
A Maneira Recomendada de Utilizar um ]AR de
Terceiros para Uso em Varios Projetos Web . . 49
A Maneira Alternativa de Utilizar Arquivos JAR
Externos (Compilacao Global e Classpath do
Servidor) . . . . 50
Otimizando Compllagoes de Varlos Pro]etos
Utilizando JARs Dependentes de Projeto . .51
Compilagdes de Producdo Automatizada Utilizando
Ant . . 51
Capitulo 10. Exemplos de Migracao . 53
Exemplo: VisualAge para Java JSP/Amostra de
Servlet (LeapYear) . . 53
Exportando Arquivos do VlsualAge para ]ava . 53
Criando um Novo Projeto Web do IBM
WebSphere Studio Site Developer . . 54
Importando os Arquivos Java e de Recursos do
Projeto para o Projeto do IBM WebSphere Studio
Site Developer . 54
Definindo Qualquer Servlet e Fazendo Qualquer
Alteragdo do Aplicativo Reestruturado . 55
Criando um Projeto do Servidor do IBM
WebSphere Studio Site Developer . . 55
Testando o Aplicativo LeapYear Migrado . 56
Exemplo: Aplicativo da Web do WebSphere Studio
"Classic” Versao 4.0 (YourCo)(Windows) . . 56
Iniciando o WebSphere Studio "Classic” Versao
4.0 e Criando uma Nova Etapa de Migracao .57
Criando um Arquivo Descritor de Configuracao
da Web . . . . 57
Criando um Arquivo de Mlgragao . 57
Iniciando o IBM WebSphere Studio Site
Developer e Importando o Arquivo WAR . 57
Criando um Projeto do Servidor do IBM
WebSphere Studio Site Developer . . 58
Testando o Aplicativo YourCo Migrado . . 58
Capitulo 11. Leitura Adicional . . 61
Avisos . - . . 63
Informagdes sobre Interface de Programa(;ao . 65
Marcas Comerciais e Marcas de Servigo . . 65

iV IBM WebSphere Application Server - Express Versio 5.1: Guia de Migragao



Capitulo 1. Visao Geral do Guia de Migracao do WebSphere
Application Server - Express

Nesta versdo do IBM® WebSphere®Application Server - Express Verséo 5.1, é
possivel migrar o cédigo a partir do:

* VisualAge para Java

IBM WebSphere Application Single Server Edition Versao 3.5

IBM WebSphere Application Server - Express Versao 5.0, 5.0.1, 5.0.2
* WebSphere Studio "Classic”

IBM WebSphere Studio Site Developer

IBM WebSphere Studio Site Developer Versdo 5 Beta, Disponibilidade
Antecipada ou Disponibilidade Geral

IBM WebSphere Studio Site Developer Versdo 5.0.1
IBM WebSphere Studio Site Developer Versao 5.1

O WebSphere Application Server - Express 5.1 é formado pelo WebSphere
Application Server 5.1 e pelo WebSphere Studio Site Developer 5.1.1. Esse primeiro
capitulo a seguir, aborda a migracdo do recurso do servidor do WebSphere
Application Server - Express. O restante desse Guia de Migragdo é destinado a
migracdo do cédigo de diferentes versdes do WebSphere Studio Site Developer.

Nota Importante a Respeito da Migra¢ao do Servidor:

A migragdo da configuracdo do servidor apenas é significativa, se vocé estiver
administrando o servidor utilizando o Administrative Console -- normalmente, em
um ambiente de produgdo. Nesse modo de operacdo, a configuragdo do servidor e
os aplicativos implementados sdo armazenados no diretério de configuragdo do
servidor. O processo de migracdo migra esses arquivos de configuracgdo e de
aplicativo. Se, por outro lado, vocé estiver utilizando o WebSphere Studio Site
Developer para configurar e implementar aplicativos no servidor remoto, nao hd
necessidade de migrar os arquivos de configura¢do do servidor. Isso acontece
porque os arquivos de configuracdo e de aplicativo sdo todos mantidos no espago
de trabalho do Studio Site Developer. O espago de trabalho sera migrado pelo
Studio Site Developer. Em seguida, vocé pode definir uma nova instancia de um
servidor do WebSphere Application Server - Express 5.1 e continuar a configuracdo
e implementagdo dos aplicativos a partir do Studio Site Developer.

Este guia esta organizado nos seguintes capitulos:

+ [Migrando o Servidor de Producio

+ [Migrando do IBM WebSphere Studio Site Developer Versao 5.1|
+ Migrando do IBM WebSphere Studio Site DeveloperVersio 5 ou Versao 5.0.1|
* [Migrando do IBM WebSphere Studio Site Developer da Versao 4.0.X

+ EEE[Migrando do WebSphere Studio "Classic” para o IBM WebSphere Studio]
Site Developer]

+ Migrando do VisualAge para Java para o IBM WebSphere Studio Site Developer]

» [Migrando do VisualAge para Java Visual Composition Editor para o Visuall
Editor para Javal

© Copyright IBM Corp. 2000, 2003 1



2

« |Configuracdo da Compilacdo (Biblioteca JARs, JARs Dependentes de Projeto)
Compilacdes Ant)|

* [Exemplos de Migracao|

¢ |Leitura Adicionall

Informacoes sobre como utilizar o WebSphere Application Server - Express podem
ser localizadas no guia Introdugio e na ajuda on-line. Leia o Guia de Instalagdo antes
de instalar o WebSphere Application Server - Express. Depois de instalar com éxito
o0 WebSphere Application Server - Express, leia o guia Introdugio e execute os
tutoriais de Introdugdo. Os tutoriais o apresentardo ao workbench, ao
desenvolvimento Java' e aos servicos da Web. Apés a conclusdo dos tutoriais, leia
este guia para migrar os recursos do aplicativo para o WebSphere Application
Server - Express.

Esse guia esta disponivel nas versdes HIML e Acrobat PDEF, no diretério /readme.
Ambas as versdes contém informacoes idénticas. Vocé pode abrir o arquivo

em qualquer navegador da Web. Para abrir o arquivo
vocé deve ter o software Acrobat Reader instalado, o qual pode ser transferido por
download a partir do endereco [www.adobe.com/products/acrobat/readstep2.htmll

Este Guia de Migragio utiliza as convengdes do Windows® em todo o processo. Por
exemplo, o "WS_Installdir\" no Windows é equivalente ao "WS_Installdir/" no
Linux.

Para obter atualizacGes futuras deste guia, consulte
fwww.ibm.com /websphere /developer /zones/studio/ transition.htmi|
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Capitulo 2. Migrando o Servidor de Producao

Migracao

Migragdo é uma atividade na qual vocé se beneficia de materiais existentes. As
tarefas e ferramentas de migracdo ajudam no upgrade do produto e de seus
pré-requisitos, na reutilizacdo de componentes do aplicativo existente quando
possivel e na transferéncia de configuragdes administrativas de sua versao anterior
para uma atual.

A migragdo de produtos do WebSphere Application Server é relativa a alavancar o
ambiente e aplicativos existentes e alterd-los para que sejam compativeis com a
versdo do produto atual.

As fungoes de migragdo do produto sdo fornecidas pelas ferramentas de migracado
no IBM WebSphere Application Server - Express, Versao 5.1. As ferramentas de
migracdo suportam a migracao do:

¢ IBM WebSphere Application Server - Express Versdo 5.0, 5.0.1, 5.0.2

» IBM WebSphere Application Single Server Edition Versdo 3.5

O assistente para instalacdo do produto detectard versdes anteriores do IBM
WebSphere Application Server - Express e fornecerd uma opgdo para executar as
ferramentas de migracdo durante a instalagdo da Versdo 5.1. Para migrar do IBM
WebSphere Application Server Versdo 3.5, é necessario executar essas ferramentas
diretamente.

Redbook de Migracao

Migrating to WebSphere V5: An End-to-End Migration Guide estd disponivel a partir
do Web site de Redbooks no endereco |http:/ /www.ibm.com /redbooks Para
localizar o Redbook, procure o ndmero do documento SG24-6910-00. O Redbook
fornece uma cobertura maior que esse artigo, incluindo informagoes sobre
planejamento com detalhes adicionais para migragdo de aplicativo e ferramentas e
amostras do WebSphere Studio Application Developer.

Migracao da Versao 3.5: Movendo para o Modelo J2EE

Os usudrios da V3.5.x fazendo upgrade para V5 estdo movendo para uma

plataforma que é baseada nas especificagdes J2EE. A tecnologia J2EE separa
claramente o desenvolvimento e a criagdo de aplicativos da administragao,
implementagdo e gerenciamento do aplicativo. A migracdo da V3.5 envolve
alteracOes nas estruturas, desenvolvimento e implementacdo de aplicativos.

As ferramentas de migragdo ajudam na transi¢do da Versao 3.5.x para a Versao 5,
através da migracao de configuracdes do sistema e da criacdo de artefatos J2EE,
incluindo o mapeamento de fun¢des de seguranca J2EE. As ferramentas de
migracdo criam aplicativos corporativos J2EE iniciais com base nas configura¢ées
da Versao 3.5.x. No entanto, devido a alteragdo significativa em estruturas de
aplicativos, planeje cuidadosamente o teste e o ajuste dos aplicativos migrados,
utilizando as ferramentas de desenvolvimento e de implementacao, para
determinar exatamente como os aplicativos funcionam no novo ambiente.
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O modelo J2EE permite o desenvolvimento de aplicativos independentemente do
ambiente de implementacdo final. Essa separagao de tarefa simplifica o processo de
promover um aplicativo do desenvolvimento inicial através da producio, ou de
movimento de um aplicativo de um servidor para outro. A intengdo é alterar
apenas os parametros de implementacdo de aplicativo e ndo o cédigo do
aplicativo.

Migrando e Coexistindo

Antes de iniciar, determine se vocé tem uma versdo existente do WebSphere
Application Server instalada na maquina em que planeja instalar o produto Versao
5.1. Se vocé tiver uma versdo anterior, serd necessario planejar se pretende copiar a
configuragdo e aplicativos da versdo anterior para a versdo nova, que é a migragdo.
A migragdo ndo desinstala a versdo anterior. O release anterior ainda é funcional.
Se vocé executd-lo ao mesmo tempo que a instalagdo da Versdo 5.1, as duas versdes
serdo coexistentes. Para executar ambas as versdes ao mesmo tempo, vocé precisara
configurar as portas de modo que elas ndo entrem em conflito. Observe que a
operacdo de migragdo apenas migra as definicdes de porta no estado em que se
encontram, a fim de que as defini¢des sejam as mesmas em ambas as versdes. O
WebSphere Application Server contém ferramentas de migracdo que fornecem toda
funcionalidade de migragdo. O assistente para instalagdo pode chamar as
ferramentas de migracdo ou vocé pode chama-las manualmente mais tarde.

Em resumo, a migracdo do IBM WebSphere Application Server - Express V5.0.x
para V5.1 é rotina habitual. E possivel utilizar o instalador para migrar e ter um
pouco ou nenhum ajuste de migragdo posterior a ser desempenhado. Ou vocé
pode utilizar as ferramentas de migracdo manualmente para salvar os dados de
configuragdo V5.0.0, V5.0.1 ou V5.0.2, desinstalar a V5.0.0, V5.0.1 ou V5.0.2, instalar
a V5.1 e utilizar as ferramentas de migragdo novamente para restaurar os dados de
configuragao.

Em resumo, a migracdo do IBM WebSphere Application Server V3.5 para IBM
WebSphere Application Server - Express V5.1 envolve alteracdes significativas em
estruturas, desenvolvimento e implementagdo de aplicativo. As ferramentas de
migracdo ajudam nessa transicdo através da migracdo de configuracdes do sistema
e da criagdo de artefatos J2EE, incluindo o mapeamento de defini¢des de seguranca
anteriores para func¢oes de seguranga J2EE. Esses mapeamentos de seguranga
permitem o acesso a recursos migrados durante a transi¢do. As ferramentas de
migragdo criam aplicativos corporativos J2EE iniciais com base nas configuragoes
da Versao 3.5.x. No entanto, devido as altera¢des significativas nas estruturas do
aplicativo, teste e ajuste com cuidado os aplicativos migrados utilizando as
ferramentas de desenvolvimento e de implementacao.

A migragdo salva os arquivos a seguir no diretério backup.

Para a Versao 3.5.x

* bin/setupCmdLine.sh (ou bin/setupCmdLine.bat para plataformas
Windows)

* classes (ndo salvas para o iSeries)
* hosts
* properties
* servlets
Para a Versao 5.0.x

* classes (ndo salvas para o iSeries)
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e config

* installableApps
e installedApps

* properties

Ferramentas de Migracao

Esse topico apresenta as ferramentas de migracao que o WebSphere Application
Server fornece. Todas as ferramentas de migracdo sdo enviadas para o diretdrio
/migration no CD-ROM do produto. E importante utilizar essas ferramentas para a
versdo do Application Server que estd sendo instalada. Elas sdo alteradas o tempo
todo. As ferramentas no CD-ROM do produto fornecem a fungdo necessaria para
migracdo de um release anterior do Application Server para o release no CD-ROM
do produto. As que se encontram no CD-ROM correspondem ao produto no
CD-ROM. Se vocé utilizar as ferramentas de migracdo de um release anterior do
Application Server, provavelmente encontrard um problema com a migragao.

WASPreUpgrade.sh (e WASPreUpgrade.bat)
Salva os dados de aplicativos e de configuragdo de uma instalagdo anterior
do WebSphere Application Server para um diretério de backup. O script
WASPostUpgrade restaura os dados de configuracdo do diretério para a
nova instalacdo. O instalador chama o script WASPreUpgrade.sh durante a
instalacdo, se vocé selecionar a migragio. E possivel também utilizar o
comando para desempenhar uma migragdo manual, apds instalar a nova
versao.

WASPostUpgrade.sh (e WASPostUpgrade.bat)
Restaura os dados de configuragdo de um release anterior.
WASPostUpgrade 1é os dados do diretério de backup onde o script
WASPreUpgrade armazenou os dados. O instalador chama o script
WASPostUpgrade.sh durante a instalacdo, se vocé selecionar a migracao. E
possivel também utilizar o comando para desempenhar uma migracao
manual, apds instalar a nova versdo.

Comando WASPreUpgrade

O script WASPreUpgrade.sh (ou WASPreUpgrade.bat) é uma ferramenta de migracao
para migracdo da configuragdo e de aplicativos de versdes ou releases anteriores
para um Application Server - Express Versao 5.1.

O arquivo de comandos estd localizado no subdiretério AppServer/bin da raiz de
instalagdo apds a instalacdo. Ele também estd disponivel diretamente a partir do
CD no subdiretério migration.
Sintaxe
WASPreUpgrade backupDirectory currentWASDirectory

[adminNodeName]

[-nameServiceHost host_name [-nameServicePort port_number ]]
[-traceString trace_spec [-traceFile file name ]]

Parametros
Os primeiros dois argumentos sdo necessarios e posicionais.

Os argumentos suportados incluem:

Capitulo 2. Migrando o Servidor de Produgiao 5



backupDirectory
Nome posicional necesséario do diretério no qual a ferramenta
WASPreUpgrade armazena a configuracdo e os arquivos salvos e a partir
do qual a ferramenta WASPostUpgrade 1é a configuragdo e os arquivos
posteriormente. A ferramenta WASPreUpgrade cria esse diretdrio, se ele
ainda ndo existir.

currentWASDirectory
Nome posicional necessério da raiz de instalacdo para a instalagdo atual
V3.5.x ou V5.0.x. Essa versao pode ser WebSphere Application Server
Standard Edition, V3.5.x, WebSphere Application Server - Express V5.0.x.

adminNodeName
Opcional, nome posicional do né que contém o servidor administrativo
para o produto atualmente instalado. O valor desse argumento deve
corresponder ao nome do né determinado na arvore de Topologias na guia
Topology do console administrativo para o produto atualmente instalado. A
ferramenta WASPreUpgrade chama a ferramenta XMLConfig utilizando
esse pardmetro. Esse parametro apenas é necessario no upgrade do
WebSphere Application Server Standard Edition, Versdo 3.5.x.

-nameServiceHost -nameServicePort
Quando especificado, a ferramenta WASPreUpgrade transmite esses
parametros opcionais para a ferramenta XMLConfig. Utilize esses
parametros para substituir o nome do host e o niimero da porta padrao
utilizados pela ferramenta XMLConfig.

-traceString -traceFile
Parametros opcionais para reunir informacdes de rastreio para o pessoal de
Servico IBM. Determine uma especificacdo de rastreio "*=all=enabled”
(com aspas) para reunir todas as informacdes de rastreio.

Registro

A ferramenta WASPostUpgrade exibe o status para a tela enquanto esta sendo
executada. Ela também salva um conjunto de informacées sobre registro mais
amplo no diretério backup. Vocé pode exibir o arquivo WASPreUpgrade.Tog com um
editor de texto.

Comando WASPostUpgrade

6

O script WASPostUpgrade.sh (ou WASPostUpgrade.bat) é uma ferramenta de
migracdo para migragdo da configuracdo e de aplicativos de versdes ou releases
anteriores para um Application Server - Express Versao 5.1.

O arquivo de comandos estd localizado no diretério AppServer/bin da raiz de
instalacao.

A ferramenta WASPostUpgrade instala todos os aplicativos migrados no diretério
AppServer/installedApps para a instalacdo da Versdo 5.1. A ferramenta inclui
aplicativos do diretério de backup que a ferramenta WASPreUpgrade cria. A
ferramenta WASPreUpgrade copia os aplicativos do diretério installedApps e
outros diretorios na versao ou release anterior.
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Sintaxe

WASPostUpgrade backupDirectory
[-serverName server_name]
[-webModuleAdditionalClasspath classpath]
[-documentRootLimit number]
[-substitute "keyl=valuel[;key2=value?;[...]1]1"]
[-portBlock port starting number]
[-backupConfig true | false]
[-replacePorts true | false]
[[-traceString trace_spec [-traceFile file name]]

Parametros

O primeiro argumento é necessério. Os argumentos suportados incluem:

serverName
Nome da instancia do servidor opcional. Assume o padrao serverl.

backupDirectory
Nome necessario do diretério no qual a ferramenta WASPreUpgrade
armazena a configuracdo e os arquivos salvos e a partir do qual a
ferramenta WASPostUpgrade 1é a configuragdo e os arquivos. A ferramenta
WASPreUpgrade cria esse diretério, se ele ainda nao existir.

-backupConfig
Parametro opcional utilizado para fazer backup da configuracdo existente
antes da configuragdo ser alterada pelas ferramentas de migracdo. O
padréo é true, para fazer backup da configuragdo.

-documentRootLimit
Parametro opcional para especificar o ntimero de arquivos que o programa
copia do campo document-root do aplicativo da Web. Ele é apenas
aplicavel para upgrades Versao 3.5.x. Se ndo for especificado, o padrao sera
300.

-portBlock
Parametro opcional utilizado para especificar o valor inicial a ser utilizado
na criagao de portas.

-substitute
Argumento opcional transmitido para a ferramenta XMLConfig.
Especifique os valores para as varidveis de seguranga a serem substituidas
(por exemplo, -substitute
"NODE_NAME=admin_node;APP_SERVER=default_server”).

No arquivo de dados XML de entrada, cada chave aparece como $key$
para substituicdo. Esse argumento substitui qualquer ocorréncia de
$NODE_NAME$ por admin_node e $APP_SERVERS$ por default_server no arquivo
XML de entrada.

Se a cadeia de substituicdo contiver pontos-e-virgulas, utilize $semiColon$
para separéd-la do delimitador ”;". Em plataformas UNIX, adicione um
caractere de escape a cada cifrdo ($) na cadeia de substituigdo (por
exemplo, \$semiColon\$).

Esse parametro é aplicavel para configuracdes salvas do Advanced Edition,
Versao 3.5.x.

-traceString -traceFile
Parametros opcionais para reunir informacdes de rastreio para o pessoal de
Servico IBM. Determine uma especificacdo de rastreio "*=all=enabled”
(com aspas) para reunir todas as informacdes de rastreio.
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-webModuleAdditionalClasspath
Parametro opcional para especificar o caminho ou o caminho e os nomes
de arquivos de diretérios ou arquivos especificos que vocé ndo deseja que
sejam copiados no arquivo WAR (Web archive). Em vez disso, o programa
adiciona os caminhos e arquivos ao atributo (ibm-web-ext.xmi)
additionalClassPath de extensdo de Médulo da Web. Isso apenas é
aplicdvel na migragdo de uma instalacdo da Versdo 3.5.x.

Registro

A ferramenta WASPostUpgrade exibe o status para a tela enquanto esta sendo
executada. Ela também salva um conjunto de informagdes sobre registro mais
amplo no diretério 1ogs. Vocé pode exibir o arquivo WASPostUpgrade.log com um
editor de texto.

Mapeamento de Configuracao durante a Migracao

8

Esse topico descreve o que é alterado durante a migracdo, que sempre envolve
uma Unica mdquina, como por exemplo um ambiente de desenvolvimento em uma
maquina independente.

Migracao da Versao 3.5 para Versao 5.x
As ferramentas de migracdo ajudam na transicdo da Versao 3.5.x para a
Versao 5, através da migracdo de configuragdes do sistema e da criacdo de
artefatos J2EE, incluindo o mapeamento de func¢des de seguranca J2EE. As
ferramentas de migracdo criam aplicativos corporativos J2EE iniciais com
base nas configura¢des da Versdo 3.5.x. No entanto, devido a alteragdo
significativa em estruturas de aplicativos, planeje cuidadosamente o teste e
o0 ajuste dos aplicativos migrados, utilizando as ferramentas de
desenvolvimento e de implementacdo, para determinar exatamente como
os aplicativos funcionam no novo ambiente.

Analise o arquivo WASPostUpgrade.Tlog para obter informagdes detalhadas
sobre os beans corporativos migrados. O modelo de programacao J2EE
especifica uma arquitetura sobre como os aplicativos sdo criados e
implementados. Como os aplicativos na Versdo 3.5.x ndo tém a mesma
arquitetura, a ferramenta WASPostUpgrade recria os aplicativos. Ela cria
todos os recursos e os beans corporativos da Web migrados em aplicativos
J2EE. Ela mapeia todos os aplicativos corporativos da instalagdo da Versao
3.5.x em aplicativos J2EE com o mesmo nome, implementados no mesmo
servidor.

A ferramenta WASPostUpgrade mapeia recursos da Web que estao
incluidos em um aplicativo corporativo, em um aplicativo J2EE padrdo que
inclui o nome do servidor. A ferramenta mapeia aplicativos da Web para
arquivos WAR J2EE. Ela combina recursos em um arquivo WAR J2EE e os
implementa na configuracdo da Versao 5.

Mapeando Detalhes da Migracao da V3.5.x para a Versao 5.x

* datasources.xml

Vocé pode utilizar um arquivo datasources.xml da Versao 3.5.x para
aumentar as defini¢des de configuragdo do DataSource. A Versdo 3.5.x
armazena o arquivo no diretério properties. As ferramentas de
migragdo migram um arquivo datasources.xml existente, combinando as
propriedades no arquivo na configuracdo do datasource e do driver
JDBC.

* Aplicativos Corporativos
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As entradas do aplicativo corporativo Versao 3.5.x sdo opcionais, elas sdo
mais freqiientemente utilizadas para organizar conjuntos de objetos
juntos para defini¢des de Seguranca. O bean corporativo e as partes de
aplicativos da Web do aplicativo corporativo apontam para suas
respectivas entradas em outras partes do arquivo xml. Cada aplicativo
corporativo é processado para criar um aplicativo J2EE com o mesmo
nome. As entradas do bean corporativo e de aplicativos da Web sao
utilizadas como ponteiros para as defini¢des de beans corporativos e de
aplicativos da Web. Os detalhes dessas entradas sao utilizados, em
seguida, para construir um aplicativo J2EE.

Para arquivos do bean corporativo, a defini¢do de arquivo JAR é
utilizada para localizar os arquivos JAR para reimplementar e adicionar
ao aplicativo J2EE. As entradas raiz de documentos de aplicativos da
Web sdo utilizadas para localizar os recursos utilizados no aplicativo da
Web (HTML, paginas JSP e assim por diante). Esses arquivos sdo
copiados para o arquivo WAR dentro do aplicativo J2EE. As entradas de
classpath de aplicativos da Web sdo utilizadas para localizar servlets e
arquivos JAR copiados para o arquivo WAR no aplicativo J2EE.

Os aplicativos corporativos sdo criados durante a migracdo da Versdao
3.5.x. Esses sdo criados como aplicativos corporativos compativeis com
J2EE 1.2 e contém os mdédulos de nivel do Servlet 2.2 e JSP 1.1. Isso
fornece a compatibilidade direta e permite a interoperabilidade com
versdes anteriores do WebSphere Application Server.

e Seguranca J2EE
O modelo de autorizacdo de seguranga na versdo 3.5.x é baseado na
nogdo de Aplicativo Corporativo e Grupos de Métodos. O produto
cruzado do aplicativo corporativo e os grupos de métodos representa

uma permissdo do WebSphere Application Server. A especificacdo J2EE
inclui um modelo de autorizacdo com base em fungdes.

Para converter do modelo de permissdao do WebSphere Application
Server na versdo 3.5.x para a fungdo com base no modelo de autorizagdo
na Versao 5, as ferramentas de migragdo criam uma relagdo um para um
de uma permissdo do WebSphere Application Server para uma nova
fungdo desse aplicativo. Portanto, para cada aplicativo corporativo e
cada grupo de métodos na Versdo 3.5.x, as ferramentas de migracao
criam uma fungdo na Versao 5, contida no descritor de implementagao
de aplicativo J2EE. Os assuntos autorizados para cada fungdo estdo
contidos em uma tabela de autorizacdo localizada na ligagao de
aplicativo J2EE.

A especificagdo J2EE inclui um modelo de autorizagdo com base em
funcdes. O WebSphere Application Server interpreta a fungdo para
significar um conjunto de permissdes de acesso a um recurso. No caso
de uma chamada de método do bean corporativo, a permissdo de acesso
ao método em um bean especifico é especificada pela permissdao a um
método. Essa permissao de método € associada a uma ou mais fungdes
no descritor de implementacdo no arquivo JAR do bean.

No caso de acesso a recursos da Web, a permissdo de acesso a uma URI
da Web e de chamada a um método HTTP nessa URI é especificada em
termos de coletas de recursos da Web e limita¢oes de seguranca na
especificacdo J2EE. O descritor de implementagao do arquivo WAR de
aplicativos da Web contém as limitagdes de segurancga e coletas de
recursos da Web.

* Niveis de JSP
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A Versdo 5 executa objetos JSP 1.0 e 1.1 como objetos JSP 1.2, que é o
tnico nivel suportado.

* Redirecionador de Servlet

A Versdo 5 ndo suporta o Redirecionador de Servlet de versdes
anteriores. As ferramentas de migragdo ignoram esses objetos.

* Alteracoes de Nomes de Pacotes do Servlet durante a Migracido da
V3.5.x para V5.x

Se a configuragdo da Versdo 3.5.x definir o servlet SimpleFileServlet, o
servlet ndo serd migrado. As ferramentas de migragdao definem o
atributo FileServingEnabled no arquivo de médulo da
Webibm-web-ext.xmi como true.

Se a configuracdo da Versdo 3.5 definir o servlet InvokerServlet, o servlet
ndo sera migrado. As ferramentas de migragdo definem o atributo
ServeServletsByClassnameEnabled no arquivo de médulo da Wev
ibm-web-ext.xmi como true.

Se a configuragdo da Versao 3.5.x definir o servlet DefaultErrorReporter,
o servlet nao serd migrado no arquivo de médulo da Web web.xml. A
migragdo utiliza o novo pacote para definir o nome da classe.

¢ Transportes

O tipo de transporte padrdo do Servlet Engine na Versdo 3.5.x é OSE
(Open Servlet Engine). Como a Versdo 5 ndo mais suporta o transporte
OSE, as ferramentas de migracdo mapeiam esses transportes para
transportes HTTP, utilizando as mesmas atribui¢des de porta. Vocé deve
adicionar manualmente as entradas do alias VirtualHost para cada porta.

Migrando Dados de Configuracao Manualmente

10

Vocé pode migrar as configuragdes administrativas com o assistente para instalagdo
ou manualmente, como essa tarefa descreve. Se decidir migrar manualmente, nao
selecione a caixa de opgdes migration no painel installation wizard migration.

Se vocé utilizar uma versdo anterior do WebSphere Application Server, o
administrador do sistema pode ter vérios aplicativos bem ajustados e defini¢des do
servidor para seu ambiente. E importante ter uma estratégia para migragio dessas
defini¢des com o maximo de eficiéncia e o minimo de perda.

E possivel desempenhar varias vezes a migragio manual incremental pela chamada
das ferramentas de migragdo, toda vez que especificar um arquivo de configuracao
diferente. Ha diversos motivos para a existéncia de multiplos arquivos de
configuracdo. Seja qual for o motivo, a migragdo de um arquivo de configuragao
por vez permite que aplicativos sejam testados incrementalmente, antes de
continuar com o préximo arquivo de configuracao.

Antes de utilizar as ferramentas de migragdo, consulte o documento Notas sobre o
Release V5.x para entender quais corregdes sdo necessdrias aplicar em versdes
anteriores. A aplicagao de corre¢des em uma versdo anterior também pode aplicar
corre¢des em arquivos que tém uma fun¢do na migragdo. Aplique quaisquer
correcOes para garantir a migragdo mais eficiente de configuracdes e aplicativos
possiveis.

A migragdo manual fornece uma abordagem de migracdo mais incremental do que
a migracdo completa fornecida pelo assistente para instalagdo. A IBM fornece um
conjunto de ferramentas de migracdo para migrar configura¢des administrativas
para o produto WebSphere Application Server - Express de qualquer edi¢do da
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V3.5.x ou V5.0.x. O processo de migracdo total serve para fazer backup da
configuracdo atual e de arquivos necessarios com a ferramenta de migragao
WASPreUpgrade, desinstalar o release anterior, instalar o produto Versdo 5 sem
selecionar a opgdo de migracdo automadtica e restaurar a configuragdo do release
anterior com a ferramenta de migracdo WASPostUpgrade.

Selecione qualquer um desses cendrios de migracdo, para obter informagdes sobre
como migrar dados de configuragdo para um né de base do WebSphere
Application Server:

» |[“Migrando da V3.5.x para a V5.1’
* |"Migrando a V3.5.x para uma Maquina V5.1 Remota” na pagina 13|

» |[“Migrando da V5.0.x para a V5.1” na pagina 15|

+ ["Migrando da Maquina V5.0.x para uma Méaquina V5.1 Remota” na pagina 15

» ["Migrando de um Sistema Operacional Ndo-Suportado” na péagina 17|

Migrando da V3.5.x para a V5.1

E possivel utilizar as ferramentas de migragio para migrar dados de configuragao
da Versdo 3.5 do WebSphere Application Server para a Versdo 5.1 do WebSphere
Application Server - Express.

Normalmente, vocé utilizaria as ferramentas de migracio WASPreUpgrade e
WASPostUpgrade da V5.1 do WebSphere Application Server para fazer upgrade da
V3.5 para a V5.1 na mesma maquina. Se o cendrio incluir a migrac¢do de uma
configuracdo da V3.5 em uma maquina para o WebSphere Application Server -
Express V5.1 em outra médquina, utilize o procedimento alternativo descrito em
[“Migrando a V3.5.x para uma Maquina V5.1 Remota” na pagina 13

Esse topico descreve o uso de ferramentas de migragdo V5.1 a serem migradas:

* WebSphere Application Server Single Server Edition, V3.5

A ferramenta WASPreUpgrade salva a configuragdo da V3.5 existente em um
diretério de migration-specific-backup. A ferramenta WASPostUpgrade utiliza esse
diretério para adicionar as defini¢des de configuragdo antigas ao novo ambiente
V5.1

Etapas para Esta Tarefa
1. Obtenha o CD-ROM do produto V5.1.

Nesse CD encontra-se o diretrio migration/bin. Esse diretério contém um
ambiente especial que vocé pode utilizar para executar a ferramenta
WASPreUpgrade sem instalar a V5.1.

2. Salve a configuragdo atual utilizando o script WASPreUpgrade do diret6rio
/migration/bin do CD-ROM do produto V5.1.
Salve a configuragdo no diretério migration-specific-backup:
WASPreUpgrade /usr/tmp/migration-specific-backup /usr/websphere/appserver yourNodeName

Verifique se o servidor administrativo do ambiente existente estd sendo
executado. A ferramenta WASPreUpgrade fornece o status para a tela e para
arquivos do log no diretério migration-specific-backup. Os nomes de
arquivos de logs ASCII comegam com a ferramenta WASPreUpgrade de texto e
incluem uma data e hora.
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A ferramenta WASPreUpgrade salva todos os arquivos dos diretorios a seguir
na configuracdo V3.5.x existente no diretério de backup:

Para a Versao 3.5.x
* bin
* classes
* hosts
* properties
e servlets

A ferramenta WASPreUpgrade salva os arquivos selecionados do diretério /bin
V3.5.x. Ela também exporta a configuragdo do Application Server existente do
repositério V3.5.x. Essa ferramenta chama a XMLConfig para exportar o
repositério V3.5 existente para o arquivo websphere_backup.xml no diretério
migration-specific-backup.

Se ocorrem erros durante a execucdo da ferramenta WASPreUpgrade, pode ser
preciso aplicar corre¢des a instalacdo da V3.5 para concluir com éxito a etapa
de exportacdo. Consulte a pagina IBM Support para obter as corre¢des mais
recentes possiveis de serem aplicadas. Na exibi¢do dessas informagoes do
InfoCenter, clique em Support para efetuar o link com a péagina IBM Support.

. Instale a V5.1 do produto WebSphere Application Server - Express Version.

Nao selecione a opgdo de migragdo, se ela aparecer.

Apbs cada uso da ferramenta WASPostUpgrade, verifique as defini¢des de
porta da V5 em dois arquivos:

* Verifique a atribui¢do da porta BOOTSTRAP_ADDRESS para serverl no arquivo
serverindex.xml

Se a porta BOOTSTRAP_ADDRESS da versao anterior for 900, a migracdo
mapeia isso para 7809. Se a porta BOOTSTRAP_ADDRESS da versao anterior
ndo for 900, a migragdo mapeia o valor para serverl em uma migragdo
Advanced Edition ou para o nome do servidor real em uma migragdo
Advanced Single Server Edition.

* Verifique as atribui¢des da porta HTTP Transport no arquivo server.xml

O processamento de WASPostUpgrade adiciona as portas HTTP Transport da
versdo anterior no arquivo server.xml da Versdo 5. Isso significa que o
serverl contém atribui¢es duplicadas da porta HTTP Transport, a partir do
painel de coexisténcia e da versdo anterior do Servidor Padrio.

. Migre a configuragdo anterior para a nova instalagdo com a ferramenta

WASPostUpgrade no diretdrio AppServer/bin do diretério raiz de instalagdo da
V5.1

A ferramenta WASPostUpgrade migra as informagdes de configuragdo da
V3.5.x criadas pela ferramenta WASPreUpgrade para a instalacdo da V5.1.
Como o produto V5.1 adere ao modelo de programacao J2EE e o produto
V3.5.x ndo adere, as alteragdes significativas sdo necessarias para aplicacdo da
configuracdo da V3.5.x em uma instalagdo da V5.1.

A ferramenta WASPostUpgrade ndo migra Amostras ou o aplicativo de console
administrativo, pois ja ha Amostras e um aplicativo do console administrativo
na V5.1.

A ferramenta WASPostUpgrade registra informacoes detalhadas em cada bean
corporativo implementado, no arquivo WASPostUpgrade.Tog.

. Pare o servidor administrativo da versdo anterior se ele estiver sendo

executado, antes de executar o né da Versao 5.
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6. A configuracdo do WebSphere Application Server apés a migragdo é uma forma
de verificar os resultados das ferramentas de migracao. E possivel também
utilizar o mapeamento de Configuragdo durante a migragdo, para verificar os
resultados da migracdo. O tépico possui uma descrigdo detalhada de como as
ferramentas de migracdo migram objetos e o que vocé deve verificar.

Migrando a V3.5.x para uma Maquina V5.1 Remota

Vocé pode utilizar as ferramentas de migragdo para desempenhar uma migragao
manual entre duas méquinas.

Normalmente, vocé utilizaria as ferramentas de migracio WASPreUpgrade e
WASPostUpgrade da V5.1 do WebSphere Application Server - Express para fazer
upgrade da V3.5 para a V5.1 na mesma maquina.

No entanto, ha alguns cenarios onde vocé deve migrar a configuragdo da V3.5 em
uma méaquina para a V5.1 em uma maquina diferente. Um desses cendrios é a
instalagdo de novas maquinas no ambiente da V5.1 mais recente, mas ha
necessidade de migrar a configuragdo da V3.5 existente em outras maquinas.

Esse topico descreve o uso de ferramentas de migragdo V5.1 a serem migradas:
* WebSphere Application Server Single Server Edition, V3.5

A ferramenta WASPreUpgrade salva a configuragdo da V3.5 existente em um
diretério de migration-specific-backup. A ferramenta WASPostUpgrade utiliza esse
diretério para adicionar as defini¢des de configuragao antigas ao novo ambiente
V5.1

Etapas para Esta Tarefa
1. Obtenha o CD-ROM do produto V5.1.

Nesse CD encontra-se o diretério migration/bin. Esse diretério contém um
ambiente especial que vocé pode utilizar para executar a ferramenta
WASPreUpgrade sem instalar a V5.1.

2. Salve a configuracdo atual utilizando o script WASPreUpgrade do diretdrio
/migration/bin do CD-ROM do produto V5.1, que deve ser montada na
maquina V3.5.

Salve a configuracdo no diretério migration-specific-backup na méquina V3.5.
WASPreUpgrade /opt/tmp/migration-specific-backup /opt/websphere/appserver adminNodeName

Verifique se o servidor administrativo do ambiente existente estd sendo
executado.

A ferramenta WASPreUpgrade fornece o status para a tela e para arquivos do
log no diretério /migration-specific-backup. Os nomes de arquivos de logs
ASCII comegam com a ferramenta WASPreUpgrade de texto e incluem uma
data e hora.

A ferramenta WASPreUpgrade salva os arquivos selecionados do diretério /bin
V3.5.x. Ela também exporta a configuracdo do Application Server existente do
repositério V3.5.x. Essa ferramenta chama a XMLConfig para exportar o
repositério V3.5 existente para o arquivo websphere_backup.xml no diretério
migration-specific-backup.
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Se ocorrem erros durante a execucdo da ferramenta WASPreUpgrade, pode ser
preciso aplicar corre¢des a instalacdo da V3.5 para concluir com éxito a etapa
de exportacdo. Consulte a pagina IBM Support para obter as corre¢cdes mais
recentes possiveis de serem aplicadas. Na exibi¢do dessas informagdes do
InfoCenter, clique em Support para efetuar o link com a péagina IBM Support.
Copie o diretério /migration-specific-backup da maquina V3.5 para a
méquina V5.1.

Utilize o ftp, o armazenamento compartilhado ou algum outro mecanismo para
copiar o arquivo para a nova maquina.

Desempenhe as etapas a seguir na maquina com a V5.1 do WebSphere
Application Server - Express..

Copie o arquivo /migration-specific-backup/websphere_backup.xml ou
/migration-specific-backup/config/server-cfg.xml e armazene-o em um
local de sua escolha, para preservar a copia como um archive.

Vocé estd copiando o arquivo porque o arquivo original sera editado na
proxima etapa.

Edite o arquivo /migration-specific-backup/websphere_backup.xml ou
/migration-specific-backup/config/server-cfg.xml para corrigir as defini¢oes
dependentes de maquinas corretas.

Faca essas altera¢des no arquivo:

a. Altere o nome do né no arquivo /migration-specific-
backup/websphere_backup.xml. Nao ha nenhum nome de né no arquivo
/migration-specific-backup/config/server-cfg.xml.

Se vocé estiver utilizando o mesmo nome do né para a maquina V5.1
utilizada para a configuracdo da V3.5 original, ndo altere o nome. Do
contrario, vocé deve alterar todas as ocorréncias do nome do n6 da V3.5
para o nome do né sendo utilizado para o WebSphere Application Server
V5.1. O nome do né ocorre em muitas sub-rotinas XML por todo o arquivo.
A falha na alteragdo de todas as ocorréncias resulta em uma migracéo
incompleta de dados.

b. Altere os nomes de caminhos no arquivo /migration-specific-
backup/websphere_backup.xml ou /migration-specific-
backup/config/server-cfg.xml.

O arquivo de configuracdo refere-se a nomes de caminhos em muitas
sub-rotinas XML por todo o arquivo. Atualize qualquer referéncia a um
arquivo fora da estrutura de diretérios V3.5 para o diretério equivalente na
nova maquina, mesmo se for necessario criar um diretério equivalente. A
implicagao de configuracdo de um ambiente correspondente significa que
pode ser preciso copiar o diretério original para a maquina V5.1. Ou pode
ser preciso instalar o software apropriado.

c. Corrija os estilos de especificagdo dos nomes de caminhos que sdo
dependentes no sistema operacional.

E necessario corrigir as especificacdes de caminho, se elas diferirem
daquelas que funcionam na maquina que estd executando a V5.1. Por
exemplo, se vocé estiver mudando da V3.5 em uma plataforma Windows
para a V5.1 em uma plataforma Linux, altere qualquer caminho especifico
do Windows no arquivo de configuragdo, para utilizar o estilo de caminho
do Linux. Mude de "c:\mystuff\somepath” para "/opt/mystuff/somepath”.

d. Altere os IDs de usudrios e senhas para corresponderem aos requisitos de
seguranca.

Pode ser preciso alterar os IDs de usudrios e senhas, se eles ndo forem
idénticos aqueles em uso na maquina V5.1.
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6.

7.

Para alterar uma senha codificada para uma senha de texto limpo, mude
<password>{xor}LCoxayht</password> para
<password>mypassword</password>.

e. Altere outras informacoes especificas da maquina.

A configuracdo pode se referir a outros produtos ou configuragées de
software que ndo existem na nova maquina. Por exemplo, a maquina antiga
pode ter um banco de dados. Possivelmente, a configuracao da V5.1 ainda
deve apontar para o banco de dados na mdquina antiga. Modifique o
datasource para apontar para o banco de dados na maquina V3.5.

Instale a V5.1 do WebSphere Application Server sem selecionar a opg¢ao de
migragao.
Adicione a configuracdo da V3.5 a configuracdo da V5.1.

Utilize a ferramenta WASPostUpgrade no diretério AppServer/bin do diretério
raiz de instalacdo da V5.1, para adicionar a configuragdo da V3.5 a
configuracdo da V5.1.

WASPostUpgrade /opt/tmp/migration-specific-backup

A ferramenta WASPostUpgrade registra informagdes detalhadas especificas a
cada bean corporativo implementado, no arquivo /migration-specific-
backup/WASPostUpgrade.log.

Migrando da V5.0.x para a V5.1

Vocé pode utilizar o programa de instalacdo da V5.1 para migrar do WebSphere
Application Server - Express V5.0.x para V5.1.

Etapas para esta tarefa:

1.

Pare o Application Server V5.0.x.

Utilize o script stopServer.sh (ou stopServer.bat) do diretério AppServer/bin da
raiz de instalacao:

stopServer.sh serverl

Vocé pode migrar um né da V5.0.x sem paré-lo. No entanto, ndo é necessario
executar o n6 para migrar sua configuragdo. As ferramentas de migracao
podem recuperar todos os dados de configuragdo enquanto o né esta parado. E
além disso, é necessario parar o né antes de iniciar o né da V5.1 que estd sendo
instalado. Portanto, vocé pode parar o né agora.

Instale o produto V5.1.
Selecione a opgdo de migracdo, quando ela aparecer.
Verifique a instalacdo do Application Server V5.1.

Utilize a ferramenta First Steps quando ela aparecer no final da instalacdo do
produto ou execute vocé mesmo o teste de verificagdo de instalacdo, se a
ferramenta First Steps ndo aparecer por algum motivo.

Vocé pode desinstalar o servidor V5.0.x para sua comodidade.

Migrando da Maquina V5.0.x para uma Maquina V5.1 Remota

Vocé pode utilizar as ferramentas de migragdo para migrar entre duas méaquinas.

Antes de Comecar
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Normalmente, vocé utilizaria as ferramentas de migracido WASPreUpgrade e
WASPostUpgrade da V5.1 do WebSphere Application Server para fazer upgrade da
V5.0.x para a V5.1 na mesma maquina.

No entanto, ha alguns cendrios onde vocé deve migrar a configuragdo da V5.0.x
em uma maquina para a V5.1 em uma méquina diferente. Um desses cenarios é a
instalacdo de novas maquinas no ambiente da V5.1 mais recente, mas ha
necessidade de migrar a configuragdo da V5.0.x existente em outras maquinas.

Essa tarefa descreve como utilizar as ferramentas de migragao da V5.1 para
desempenhar a migracao.

A ferramenta WASPreUpgrade salva a configuragdo da V5.0.x existente em um
diretério de migration-specific-backup. A ferramenta WASPostUpgrade utiliza esse
diretério para adicionar as defini¢des de configuragdo antigas ao novo ambiente
V5.1

Etapas para Esta Tarefa
1. Obtenha o CD-ROM do produto V5.1.

Nesse CD encontra-se o diretdrio migration/bin. Esse diretério contém um
ambiente especial que vocé pode utilizar para executar a ferramenta
WASPreUpgrade sem instalar a V5.1.

2. Salve a configuragdo atual utilizando o script WASPreUpgrade do diret6rio
/migration/bin do CD-ROM do produto V5.1, que deve ser montada na
maéquina V5.0.x.

Salve a configura¢do no diretério migration-specific-backup na maquina
V5.0.x.

WASPreUpgrade /opt/tmp/migration-specific-backup /opt/websphere/appserver

A ferramenta WASPreUpgrade fornece o status para a tela e para arquivos do
log no diretério /migration-specific-backup. Os nomes de arquivos de logs
ASCII comegam com a ferramenta "WASPreUpgrade” de texto e incluem uma
data e hora.

3. Copie o diretério /migration-specific-backup da maquina V5.0.x para a
méquina V5.1.

Utilize o ftp, o armazenamento compartilhado ou algum outro mecanismo para
copiar o arquivo para a nova maquina.

4. Instale a V5.1 do WebSphere Application Server sem selecionar a opgdo de
migragao.
5. Adicione a configuracdo da V5.0.x a configuragdo da V5.1.

Utilize a ferramenta WASPostUpgrade no diretério AppServer/bin do diretério
raiz de instalagdo da V5.1, para adicionar a configuracdo da V5.0.x a
configuracdo da V5.1.

WASPostUpgrade /opt/tmp/migration-specific-backup

A ferramenta WASPostUpgrade registra informagdes detalhadas especificas a
cada bean corporativo implementado, no arquivo /migration-specific-
backup/WASPostUpgrade.log.

6. Modifique a configuragdo utilizando as interfaces de administra¢do do
WebSphere Application Server 5.1.

Faga estas alteracoes:

a. Altere os IDs de usudrios e senhas para corresponderem aos requisitos de
seguranca.
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7.

Pode ser preciso alterar os IDs de usudrios e senhas, se eles ndo forem
idénticos aqueles em uso na maquina V5.0.x.

b. Altere outras informacoes especificas da maquina.

A configura¢do pode se referir a outros produtos ou configura¢ées de
software que ndo existem na nova maquina. Por exemplo, a mdquina antiga
pode ter um banco de dados. Modifique o datasource para apontar para o
banco de dados na méaquina antiga.

Vocé pode desinstalar o servidor V5.0.x para sua comodidade.

Migrando de um Sistema Operacional Nao-Suportado

Vocé pode migrar uma versao anterior do release do WebSphere Application Server
Versdo 3.5.x ou Versdo 5.0.x que estd sendo executada em um sistema operacional
que a Versdo 5.1 ndo suporta.

Etapas para Esta Tarefa

1.

2.

Inicie o WebSphere Application Server Versdo 3.5.x ou Versdo 5.0.x
Administrative Server.

Execute a ferramenta de migracdo da linha de comandos WASPreUpgrade.

Ha duas opgdes. Vocé pode executar o comando do diretdrio migration\bin (ou
migration/bin) no platform_root do CD-ROM Versdo 5.1. Ou, pode copiar os
arquivos no diretério do CD-ROM para um diretério criado na unidade de
disco rigido.

Identifique o release Versao 3.5.x ou 5.0.x e identifique um diretério de backup
onde o comando armazena arquivos de configuracdo e aplicativos de migragao
da versdo anterior. Consulte o tépico WASPrellpgrade para obter a sintaxe de
comando.

a. Execute o comando a partir do diretério migration\bin (ou migration/bin)
no platform_root do CD-ROM Verséo 5.1.

Identifique o diretério de backup e o local dos arquivos de configuragdo.
Unidade_de CD:\WASPreUpgrade backupDirectory filepath\WebSphere\AppServer yourNodeName

Se isso funcionar, va para a Etapa 4. Se ndo funcionar por algum motivo,
desempenhe as etapas 2B a 2F.

o

Crie um diretério migration em sua unidade de disco rigido.

o

Copie os arquivos WASPreUpgrade.bat (ou WASPreUpgrade.sh) e
setupCmdLine.bat (ou setupCmdLine.sh) do diretério migration\bin\ (ou
migration/bin/) no platform_root do CD-ROM Versdo 5.1, para o diretério
criado em sua unidade de disco rigido.

d. Edite o arquivo setupCmdLine.bat (ou setupCmdLine.sh) no novo diretdrio.
Altere as seguintes variaveis:
* WAS_HOME para apontar para o caminho completo do diretério de
migragdo criado
* JAVA_HOME para apontar para o caminho completo do diretério IBM
Developer Kit ou Java

e. Assegure que o bit executavel esteja ativado para os arquivos
setupCmdLine.sh e WASPreUpgrade.sh no diretério migration/bin no
UNIX-based platform_root do CD-ROM Versao 5.1, se vocé estiver fazendo
backup de uma instalacdo com base no UNIX.

f. Execute o comando a partir do diretério migration criado.

Identifique o diretério de backup e o local dos arquivos de configuragéo.
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yourMigrationDirectory\WASPreUpgrade backupDirectory filepath\WebSphere\AppServer yourNodeName
3. Encerre o WebSphere Application Server Versao 3.5.x ou Versdo 5.0.x.

4. Compacte com o comando tar ou zip o diretério de backup e envie-o por FTP
para outro sistema.

5. Instale o novo sistema operacional, mantendo o mesmo nome do host.

Se possivel, mantenha o mesmo nome do sistema e senhas do sistema antigo.
Coloque todos os arquivos do banco de dados relacionados a aplicativos que
estdo sendo migrados, no mesmo caminho que o sistema anterior. Em geral,
tente manter os mesmos caminhos. No entanto, ndo instale a Versao 5.1 no
mesmo diretério que a versdo anterior. Se vocé ndo alterar os caminhos e
nomes, poderd editar os arquivos de configuragdo XML para refletir as
alteragdes. Faga tais altera¢des antes de executar o comando WASPostUpgrade
a seguir.

6. Envie por FTP o diretério de backup do outro sistema e descompacte-o.

7. Instale o WebSphere Application Server- Express, Versdo 5.1. Nao selecione a
opgdo de migracdo, se ela aparecer.

8. Execute a ferramenta de migragdo da linha de comandos WASPostUpgrade, a
partir do diretério bin da raiz_de_instalacdo da Versado 5.1.

Especifique o diretério de backup (e qualquer nome de arquivo de configuragao
que ndo seja padrdo no diretério) criado pelo comando WASPreUpgrade.
Consulte o tépico WASPostUpgrade para obter a sintaxe de comando correta.

install_root\bin\WASPostUpgrade WAS_HOME\migration
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Capitulo 3. Migrando do IBM WebSphere Studio Site
Developer Versao 5.1

Este capitulo cobre os seguintes topicos de migracao:
* Migrando Projetos J2EE para Utilizar o Suporte do Server Targeting

* A geracdo do assistente requer um pacote Java para JDK 1.4

Migrando Projetos J2EE para Utilizar o Suporte do Server Targeting

No IBM WebSphere Studio Site Developer Versao 5.1.1, ha uma nova funcdo Server
Targeting adicionada. Por padrao, essa funcdo estd desativada, vocé precisa ativa-la
na pagina Preferences do J2EE selecionando Window > Preferences > J2EE.
Detalhes funcionais sobre a funcdo Server Targeting podem ser localizados na
documentacdo do produto IBM WebSphere Studio Site Developer. Quando a
fungdo estiver ativada, vocé terd a opgao de atingir um determinado servidor de
aplicativos. Esse recurso foi implementado para suportar o JDK 1.4, que é o JRE
para o WebSphere Application Server Versdo 5.1 fornecido com o IBM WebSphere
Studio Site Developer Versao 5.1.1. Os projetos EJB que se beneficiam do suporte
Server Targeting ndo tém compatibilidade reversa com as versdes anteriores do
IBM WebSphere Studio Site Developer, por isso, ndo podem ser compartilhados com
usudrios que trabalham em versdes anteriores do IBM WebSphere Studio Site
Developer (por exemplo, IBM WebSphere Studio Site Developer Versdo 5.1, IBM
WebSphere Studio Site Developer Versdo 5.0.1). O IBM WebSphere Studio Site
Developeroferece uma maneira de obter compatibilidade reversa com esse recurso
ativado e é descrito em [“Compatibilidade Reversa com o Suporte Ativado do|
Server Targeting” na pagina 19| O motivo dessa incompatibilidade é que a funcdo
do Server Targeting altera o arquivo .classpath em um projeto do J2EE e as novas
entradas do arquivo .classpath ndo podem ser reconhecidas por versdes anteriores
do WebSphere Application Server - Express.

Compatibilidade Reversa com o Suporte Ativado do Server

Targeting
Com o suporte ativado do Server Targeting, os projetos J2EE com servidores
alcangados podem ser revertidos para ndo utilizarem o suporte do Server
Targeting, modificando o servidor de destino para uma opg¢do No target server
specified disponivel no didlogo Modify Target Server. O didlogo Modify Target
Server é ativado a partir do menu pop-up (Target Server > Modify) em um projeto
J2EE na exibicdo Resource Navigator ou J2EE Perspective. O servidor de destino
também pode ser modificado para um servidor Sem destino especificado na pagina
de propriedades do J2EE (Properties > J2EE) para projetos EAR, EJB, Application
Client e Connector. Para um projeto da Web, a defini¢do do servidor de destino
encontra-se na pagina de propriedades da Web (Properties > WEB). Detalhes
funcionais sobre a fun¢do de modificagdo de Destino do Servidor podem ser
localizados na documentacdo do IBM WebSphere Studio Site Developer. Quando a
opcdo No target server specified é utilizada, o arquivo .classpath é revertido para
o estilo compativel com as versdes anteriores do IBM WebSphere Studio Site
Developer e o .server é removido do projeto.

Nota: Somente projetos do J2EE do Server Targeted podem ser implementados no
WebSphere Application Server Versdo 5.1 e explorar o suporte do JDK 1.4.
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A Geracao do Assistente Requer um Pacote Java para JDK 1.4
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Devido a uma alteragdo no JDK 1.4, o usudrio deve especificar um pacote Java
quando utilizar os assistentes para Paginas da Web do Banco de Dados e do Java
Bean para gerar paginas para a serem executadas no IBM WebSphere Studio Site
Developer Versdo 5.1.1. Esse problema ocorrera, se o gabarito View Bean for
utilizado para o assistente para Paginas da Web do Java Bean ou para o Padrédo de
Detalhes Principais do Java Beans do IBM Database Access. Isso se aplica a
projetos que contém péginas e arquivos .java anteriormente gerados com esses
assistentes que nao especificaram um pacote durante a criagdo. Para o cddigo que
foi anteriormente gerado, mova os arquivos .java para um pacote. Em seguida,
atualize os arquivos .jsp, atualize as instrugdes de importagdo e as informacdes
sobre classes. No arquivo web.xml do projeto, atualize a entrada servlet-class.
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Capitulo 4. Migrando do IBM WebSphere Studio Site
Developer Versao 5 ou Versao 5.0.1

Este capitulo cobre os seguintes topicos de migracao:

* WSWB (WebSphere Studio Workbench) na Versao 5, na Versdo 5.0.1 e na Versao
5.1

 Utilizando o Espago de Trabalho do WebSphere Studio Versdo 5.1.1 com a Versao
5.0

¢ Migrando Projetos Java da Versdo 5 ou da Versao 5.0.1

* Compartilhando Projetos entre a Versdo 5 ou Versao 5.0.1 e a Versao 5.1
Utilizando um Sistema SCM (Source Code Management)

* Migrando Projetos da Web

* Convertendo Projetos da Web para Struts 1.1

* Funcdo de Migracdo Adicionada a Migragdo de Projetos J2EE

* Alteragdes nas Ferramentas de Servicos da Web

* Alteragoes Feitas nas Ferramentas de Criacdo de Perfil

* Problemas de Compatibilidade Conhecidos do Assistente de Gabarito

WebSphere Studio Workbench na Versao 5, na Versao 5.0.1 e na

Versao 5.1

O IBM WebSphere Studio Site Developer Versao 5.1.1 é baseado no novo WSWB
(WebSphere Studio Workbench) 2.1.2 com base no Eclipse. Ha algumas diferencas
entre as versdes 2.1.2 e 2.0.3 ou 2.0.2. Para obter uma informacao detalhada sobre
as diferencas, consulte o arquivo leia-me localizado no diretério
WS_Installdir\eclipse\readme (em que WS_Installdir é o caminho onde vocé
instalou o IBM WebSphere Studio Site Developer.

O IBM WebSphere Studio Site Developer Versao 5.0 foi baseado no WSWB 2.0.2
com base no Eclipse e o IBM WebSphere Studio Site Developer Versao 5.0.1 foi
baseado no WSWB 2.0.3 com base no Eclipse. Ndo ha diferengas significativas entre
02.0.2 e 0 2.0.3. O release do IBM WebSphere Studio Site Developer Versao 5.0.1
era um fix pack do Gerenciador de Atualizacdo instalado na parte superior do IBM
WebSphere Studio Site Developer Versao 5.0.

Utilizando o Espaco de Trabalho do IBM WebSphere Studio Site
Developer Versao 5.1.1 com a Versao 5.0

Quando o IBM WebSphere Studio Site Developer Versao 5.1.1 € iniciado pela
primeira vez utilizando um espago de trabalho do IBM WebSphere Studio Site
Developer Versao 5.0 existente, aparece uma caixa de didlogo mostrando uma
maneira de migrar da Versao 5.0. Clique em OK para migrar do espago de
trabalho da Versdo 5.0 ou clique em Cancel para parar o inicio do IBM WebSphere
Studio Site Developer.

Quando o espaco de trabalho é migrado ainda é possivel utilizd-lo com a Versao
5.0, pois os metadados dos novos recursos de projeto sdo ignorados e podem ser
lidos pela Versao 5.0. Nao é possivel fazer nenhuma alteragdo na Versdo 5.0 aos
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projetos no espago de trabalho que teriam efeito sobre os metadados ou
sobrescreveriam os metadados do novo recurso de projeto para projetos.

Migrando Projetos Java da Versao 5 ou da Versao 5.0.1

Migrar projetos Java da Versdo 5 ou da Versdo 5.0.1 é muito simples e automatico.
Quando os projetos sdo carregados no espaco de trabalho da Versdo 5.1.1, ndo
ocorrem alteracdes de metadados nos arquivos .classpath ou .project, a menos que
vocé tente utilizar os novos recursos disponiveis na Versao 5.1.1.

Compartilhando Projetos entre a Versao 5 ou a Versao 5.0.1 e a Versao
5.1.1 Utilizando um Sistema SCM (Source Code Management)

E necessario cuidado especial quando um projeto em um repositério de equipe esta
sendo carregado e operado por desenvolvedores utilizando o IBM WebSphere
Studio Site Developer Versdo 5 e IBM WebSphere Studio Site Developer Versao
5.1.1. O problema geral é que a existéncia, o contetdo e a interpretacao de
arquivos de metadados nos espacos de trabalho podem ser especificos para um
recurso especifico ou versdo de plug-in e diferir entre as versdes. As garantias de
compatibilidade de espacos de trabalho cobrem apenas os casos em que todos os
desenvolvedores fazem upgrade dos espagos de trabalho do IBM WebSphere
Studio Site Developer na etapa travada. Nesses casos ndo deve haver problemas
com metadados compartilhados. No entanto, quando alguns desenvolvedores estdo
trabalhando no IBM WebSphere Studio Site Developer Versdo 5.1 enquanto outros
estdo trabalhando no IBM WebSphere Studio Site Developer Versdo 5, ndo existem
essas garantias. Esta se¢do aconselha sobre o que fazer e o que néo fazer.

O modo de falha tipica é reconhecido pelo usuario do IBM WebSphere Studio Site
Developer Versao 5.1.1. Os metadados da Versdo 5.1.1 sdo perdidos quando um
usudrio da Versao 5 salva alteracdes e consolida os arquivos de metadados
atualizados no repositorio. A seguir, veja algumas coisas que podem dar errado:

¢ Um usuario trabalhando no IBM WebSphere Studio Site Developer Verséo 5.1.1
cria ou modifica um projeto de uma maneira que resulta em alteracdes em um
arquivo de metadados compartilhado que se baseia em informagdes especificas
da Versdo 5.1.1. Em seguida, o usudrio consolida os arquivos de projeto
atualizados, incluindo o arquivo de metadados compartilhado, no repositério
compartilhado.

* Outro usuario trabalhando no IBM WebSphere Studio Site Developer Versao 5
compartilha esse projeto a partir do mesmo repositério. As informacdes
especificas da Versdo 5.1.1 no arquivo de metadados compartilhado ndo sdo
compreendidas pelo IBM WebSphere Studio Site Developer Versdo 5 e
geralmente sdo descartadas ou ignoradas sem aviso. O usudrio modifica o
projeto de uma maneira que resulta em altera¢gdes no arquivo de metadados
compartilhado, fazendo com que o arquivo de metadados compartilhado seja
regravado sem as informagdes especificas da V5.1.1. O usudrio consolida os
arquivos de projeto atualizados, incluindo o arquivo de metadados
compartilhado, no repositério compartilhado. Geralmente o usudrio néo esta
ciente de que informagdes compartilhadas foram perdidas como resultado de
suas acoes.

¢ Um usuaério trabalhando no IBM WebSphere Studio Site Developer Verséo 5.1.1
obtém as altera¢des para um projeto do repositério compartilhado, incluindo o
arquivo de metadados compartilhado atualizado. O usudrio pode nédo estar
ciente de que foi executada uma etapa retrograda até as coisas comecarem a
apresentar problemas posteriormente.
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Segue uma lista de detalhes a serem observados quando o projeto for
compartilhado entre usudrios do IBM WebSphere Studio Site Developer Versao
5.1.1 e Versdo 5 ou Versao 5.0.1:

* Pastas e arquivos compartilhados

Esse suporte foi adicionado no IBM WebSphere Studio Site Developer Versao
5.1.1. As informagdes sobre os recursos vinculados estdo gravadas no arquivo
.project.

Recomendacgdo: Nao utilize. Melhor ainda, desative os recursos vinculados
utilizando a pagina de preferéncias Workbench > Linked Resources.

e Construtores de ferramenta externa (Ant)

As informacdes sobre construtores de ferramentas externas estdo gravadas no
arquivo .project. O formato das informagdes alteradas entre a Versdo 5 e a Versao
5.1.1. Os construtores criados ou alterados na Versdo 5.1.1 utilizam o novo
formato, que ndo é compreendido por um espago de trabalho da Versdo 5. Os
construtores criados na Versdo 5 utilizam o formato antigo e continuam
funcionando na Versao 5.1.1.

Recomendacio: Sempre crie ou edite construtores de ferramentas externas a
partir de um espago de trabalho da Versdo 5.

* Padrdes de exclusao opcional em entradas de origem Java no caminho da
classe de compilacao

Esse suporte foi adicionado. Essas informagdes estdo gravadas no arquivo
.classpath.

Recomendacio: Nao especifique padroes de exclusdo. Melhor ainda, desative os
padroes de exclusdo utilizando a pégina de preferéncias Java > Compiler >
Build Path.

* Pastas de saida associadas a entradas de origem Java no caminho da classe de
compilagao
Esse suporte foi adicionado. Essas informagdes estdo gravadas no arquivo
.classpath.

Recomendagao: Nao especifique nada diferente da pasta de saida padrdo (para
todo o projeto). Melhor ainda, desative as diversas localizagdes de saida
utilizando a pagina de preferéncias Java > Compiler > Build Path.

e Caminho da raiz anexa de origem associada as entradas da biblioteca Java no
caminho da classe de compilacao

Ao conectar um arquivo ZIP de origem a uma biblioteca JAR no caminho de
construcdo Java, o prefixo do caminho raiz da origem é deduzido
automaticamente. Isso foi alterado a partir da Versdo 5, em que o prefixo podia
ser definido explicitamente através interface com o usudrio e explicitamente
gravado no arquivo .classpath. Conseqilientemente, um projeto Java criado em
um espago de trabalho 5.1.1 pode ndo localizar a origem conectada.

Utilize a Versdo 5 para especificar o caminho de raiz anexa de origem. Na
Versao 5.1.1, é fornecida flexibilidade adicional de conexdo da origem. Vocé pode
fornecer uma pasta em vez de um arquivo JAR ou ZIP como conexdo da origem
e pode conectar a origem a uma pasta de arquivos de classe; essa funcionalidade
ndo estd disponivel na Versdo 5 (na qual as informagdes da Versdo 5.1.1 sdo
ignoradas).

* Contéineres de caminho da classe PDE para plug-ins dependentes

A utilizacdo do PDE por contéineres do caminho de classe foi adicionada. Os
contéineres do caminho de classe estdo gravados no arquivo .classpath. Se os
contéineres do caminho de classe PDE forem utilizados, um espago de trabalho
da Versdo 5 terd entradas do caminho de classe ndo-resolvidas e, portanto, a
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maioria das capacidades Java (incluindo compilagao, pesquisa, execugao,
depuracdo) ndo produzira os resultados esperados.

Recomendagdo: Assegure-se de que a defini¢do na pédgina de preferéncias
Plug-in Development > Java Build Path Control para a utilizagdo de
contéineres do caminho de classe esteja desativada antes de criar quaisquer
novos projetos de plug-in (ou fragmento).

Migrando Projetos da Web

Os nomes de pastas sdo Java Source e Web Content. Os nomes das pastas padrao
para novos projetos da Web sdo configurdveis por meio de uma pagina de
preferéncias (Window > Preferences > Web Tools > New Project). Os nomes
padrao agora sdo JavaSource e WebContent. Esses nomes padrao serdo utilizados
apenas para novos projetos da Web. Os projetos da Web criados em versdes
anteriores a esse release continuardo a funcionar utilizando os nomes antigos. O
mesmo acontece com os projetos Estaticos da Web.

Se vocé optar por alterar os nomes das pastas de origem para projetos 4.0.x e 5.0
na Versdo 5.1.1, utilize a agdo do menu pop-up Rename na exibi¢do Navigator. A
acdo do menu pop-up Rename renomeia os nomes das pastas e corrige o caminho
de construgdo Java para os projetos da Web 4.0.x e 5.0.x.

Para a pasta JavaSource, a acdo do menu pop-up Rename funciona na exibigao
Project Navigator e na exibi¢do Packages. Para a pasta WebContent, a acdo do
menu pop-up Rename funciona na exibi¢do Resource Navigator e na exibicdo
Project Navigator.

Se um projeto da Web de uma versdo anterior a esse release for salvo em um
repositério SCM e, em seguida, carregado na Versao 5.1, ele manterd a estrutura
antiga com as pastas source e webApplication. Qualquer uma das duas estruturas
sera construida corretamente.

Nota: Se os usudrios optarem por renomear os nomes das pastas Java Source e
Web Content, eles deverdo atualizar manualmente quaisquer scripts de
construgdo automatizados; deverdo alterd-los para utilizar os novos nomes
das pastas.

Convertendo Projetos da Web para o Struts 1.1

O tempo de execugdo das ferramentas do Struts foi atualizado da Versdo 1.1 Beta 2
na Versdo 5 para a Versdo 1.1. No IBM WebSphere Studio Site Developer Versdo 5
(Disponibilidade Geral), ao criar um projeto da Web, vocé tem a opcdo de
adicionar o suporte a Struts ao projeto. Vocé pode optar pelo Struts 1.0.2 ou pelo
Struts 1.1 Beta 2. No IBM WebSphere Studio Site Developer Versdo 5.1.1, a dltima
opgao € substituida pelo Struts 1.1. Se tiver criado projetos da Web do Struts 1.1
Beta 2 no IBM WebSphere Studio Site Developer Versao 5.0, vocé pode converté-los
para o Struts 1.1, porém isso ndo é necessdrio, pois o Struts 1.1 Beta 2 ainda é
suportado. Caso possua projetos da Web do Struts 1.1 Beta 2 que deseja converter
para o Struts 1.1, sera necessario proceder da seguinte forma:

1. Carregue os projetos do Struts 1.1 Beta 2 em um espaco de trabalho do IBM
WebSphere Studio Site Developer Versao 5.1.1.

2. Crie um novo projeto da Web do Struts 1.1 denominado Struts11. Isto fornece
acesso conveniente aos artefatos do Struts 1.1 que serdo necessarios durante a
conversdo de projetos reais. Vocé pode excluir esse projeto quando tiver
concluido.
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3. Para cada projeto do Struts 1.1 Beta 2 que vocé deseja converter para o Struts

1.1, proceda da seguinte forma:

a. Exclua os seguintes arquivos .jar do diretério Web Content/WEB-INF/lib do
seu projeto: commons-*jar e struts.jar.

b. Copie os seguintes arquivos .jar do diretério Struts1l/WebContent/WEB-
INE/lib para o diretério Web Content/WEB-INF/lib do seu projeto:
commons-*jar e struts.jar.

c. Exclua os seguintes arquivos .tld do diretério Web Content/ WEB-INF do
seu projeto: struts-*.tld.

d. Copie os seguintes arquivos .tld files do diretério
Struts11/WebContent/ WEB-INF para o diretério Web Content/ WEB-INF do
projeto: struts-*.tld.

Todas as informagdes acima também serdo aplicaveis se vocé estiver movendo um
projeto da Web do Struts 1.1 Beta 3 no IBM WebSphere Studio Site Developer
Versdo 5.0.1 para o Struts 1.1.

Alteracoes nas Ferramentas de Servigos da Web

As ferramentas de servigos da Web adicionaram dois novos protocolos de tempo
de execugdo do IBM WebSphere Application Server Versao 5.0.2 que sao
executados somente no WebSphere Application Server Versao 5.0.2. Ndo deve
haver migracdo obrigatéria, pois o IBM WebSphere Studio Site Developer Versao
5.1 e o WebSphere Application Server Versdo 5.0.2 suportardo os protocolos de
tempo de execugdo novos e antigos. O IBM WebSphere Studio Site Developer
Versdo 5.1 ird gerar e implementar trés protocolos de tempo de execugdo de
artefatos de servicos da Web: o antigo protocolo de tempo de execucao "IBM
SOAP" que é executado no WebSphere Application Server Versao 4.x e Versdo 5.x;
o novo protocolo de tempo de execugdo "IBM WebSphere 5.0.2 runtime” que é
executado apenas no WebSphere Application Server Versdo 5.0.2 e o novo
protocolo de tempo de execugdo "Apache Axis 1.0" que é executado apenas no
WebSphere Application Server Versdo 5.0.2.

Os usudrios devem ser capazes de reutilizar os arquivos EAR e WAR relacionados
a servigos da Web e projetos da Versao 5 sem nenhuma alteracdo na Versao 5.1.1.
Para que convertam os clientes e servigos da Web para o novo protocolo de tempo
de execugdo do IBM WebSphere 5.0.2 e tirem vantagem dos padrées JSR 101, 109,
WS-1 e WS-Security, eles terdo que ser gerados novamente através do assistente
para servigcos da Web. O explorador de servicos da Web continuara
automaticamente a ler os favoritos do usudrio, embora o arquivo de dados fisicos
seja movido automaticamente para uma nova localizagéo.

Alteracoes Feitas nas Ferramentas de Criacao de Perfil

Ao migrar um espaco de trabalho da Versdo 5, vocé receberd uma mensagem de
erro pop-up "Problems occurred restoring workbench”. Essa mensagem aparecerd
se a perspectiva Profiling estiver aberta no momento da migragdo e se as exibi¢oes
Heap ou Instance Statistic estiverem visiveis na perspectiva Profiling. Isso ocorre
porque as exibi¢des Heap e Instance Statistic existentes na Versdo 5 foram
removidas. Essa mensagem também aparecera se a perspectiva Profiling estiver
aberta no espago de trabalho no momento da migracdo. A mensagem de erro pode
ser ignorada com segurangca clicando em OK.
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Problemas Conhecidos de Compatibilidade do Assistente para
Gabarito

Para utilizar um gabarito personalizado que foi criado na Versao 5, vocé deve
carregar o gabarito personalizado, reconecté-lo ao banco de dados e salva-lo. Na
préxima vez que vocé recarregar o gabarito personalizado salvo, a conexdo sera
verificada.

Os artefatos gerados do J2EE 1.2 criados nesse release podem néo ser lidos pelo
IBM WebSphere Studio Site Developer Versao 4.0.3 e executados nos ambientes de
teste da Versdo 4.0.3. Como o assistente Template nédo foi fornecido com a Versao
4.0.3, ndo é mantida a compatibilidade reversa para essa versao.

Os aplicativos de gabarito gerados nesse release podem ser executados na Versao 5,

se nas preferéncias do projeto da Web a pasta de origem Java for denominada
"Java Source” e a pasta de conteido da Web for denominada "Web Content”.
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Capitulo 5. Migrando do IBM WebSphere Studio Site
Developer Versao 4.0.x

Este capitulo abrange a migracdo do IBM WebSphere Studio Site Developer Versao
4.0.x para a Versao 5.

Ha dois métodos suportados, que podem ser utilizados para migrar seus projetos
do IBM WebSphere Studio Site Developer Versao 4.0.x para Versao 5. Cada um
desses métodos estd descrito em mais detalhes abaixo:

+ Utilizando um sistema SCM (Software Configuration Management) como o CVS
(Concurrent Versioning System) ou Rational® ClearCase®. Esse é o método
recomendado.

* Exportando seus projetos da Versao 4.0.x e, em seguida, importando-os para esta
edi¢do. Esse método migra tudo, exceto as informagdes do caminho de
construgdo do projeto.

e Utilizando sua area de trabalho Versdo 4.0.x existente. Esse método nao é
suportado por razdes que serdo explicadas posteriormente.

Observe que a migracdo da Versdo 4 para a Versdo 5 ndo altera automaticamente o
nivel J2EE do projeto, visto que a Versdo 5 ainda pode ser compilada e
implementada no WebSphere Application Server Versdo 4. Todos os tipos de
projetos J2EE, inclusive projetos da Web, podem ser migrados utilizando o
assistente J2EE Migration disponivel no IBM WebSphere Studio Site Developer.
Para acessar o assistente J2EE Migration, clique com o botdo direito em um projeto
do tipo J2EE e selecione Migrate > J2EE Migration Wizard.

Diferencas entre IBM WebSphere Studio Site Developer Versao 4.0.x e
Versao 5

Segue uma lista parcial dos aperfeicoamentos desde a Versao 4.0.x:

¢ O IBM WebSphere Studio Site DeveloperVersao 5 pode gerar cédigo para o
WebSphere Application Server Versdo 4.0 ou Versdo 5, e inclui os Ambientes de
Teste do WebSphere Application Server Versao 4.0.4 e Versao 5.

* O nivel do J2EE dos EARs (Enterprise Applications Archive) foi alterado de 1.2
para 1.3 para os projetos do WebSphere Application Server Versao 5.

— Os EARs do J2EE 1.2 serdo executados no WebSphere Application Server
Versao 4.0.x ou no WebSphere Application Server Versado 5.

* O nivel de especificagdo dos EJB (Enterprise Java Beans) mudou de 1.1 para 2.0
para EARs do WebSphere Application Server Versdo 5.

— ainda sao suportados e podem fazer parte dos EARs do WebSphere
Application Server Versao 4.0.x J2EE 1.2 ou da Versao 5 J2EE 1.3.

* O nivel de J2EE dos aplicativos da Web (WARs) mudou de 1.2 para 1.3, para
projetos do WebSphere Application Server Versdo 5.

— O nivel de JSP mudou de 1.1 para 1.2 e o nivel de Servlet mudou de 2.2 para
2.3

— Os projetos da Web (WARs) dindmicos 1.2 ainda sdo suportados e podem
fazer parte dos EARs do J2EE 1.2 do WebSphere Application Server Versdao
4.0.x ou dos EARs do J2EE 1.3 da Verséao 5.
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* Na Versdo 5, vocé pode criar projetos da Web estaticos, assim como projetos da
Web dindmicos. Em um projeto estatico da Web vocé conseguird apenas criar
contetido servido por um servidor HTTP tradicional (HTML, JavaScript ",
imagens, texto etc.).

* O workbench subjacente, que é baseado no projeto Eclipse de codigo fonte
aberto, mudou da Versdo 1.0 para a Versdo 2.0.

— Ha& um novo construtor Java muito aprimorado

— Essa é uma nova interface VCM (Version Control Management) muito
aprimorada para fornecedores de SCM (Software Configuration Management)

Alteracoes do WebSphere Application Server e Ferramentas de
Conversao do Servlet/JSP

O [WebSphere InfoCenter|
[www.ibm.com/software/webservers/appserv/doc/v40/aes/infocenter/
index.html] tem as seguintes informacdes:

» Diferencas entre o WebSphere Application Server Versio 3.5 e 4.0
[www.ibm.com/software /webservers /appserv/doc/v40/aes/infocenter /was /|

|03.htm1| .

* DPara obter informacdes sobre a migragdo para o WebSphere Application Server
Versao 5.0 a partir da Versdo 3.5 ou 4.0, va para o InfoCenter do WebSphere em
[www.ibm.com /software /webservers/appserv /infocenter.html] e siga as etapas
abaixo para navegar até a pagina de migragao.

1. No primeiro link, Application Server for distributed operating systems,
selecione o idioma de sua preferéncia.

2. Selecione o link All topics by activity, que esta localizado no canto superior
esquerdo.

3. Selecione o link Migrating.

Migrating to WebSphere V5.0 An End-to-End Migration Guide é um bom recurso para
obtencdo de informacdes sobre migracdo da Versdo 3.5 e 4.0 para a Versdo 5
[www.redbooks.ibm.com /pubs /pdfs/redbooks /s¢246910.pdf]].

A pagina de downloads do WebSphere Application Server
[www14.software.ibm.com /webapp /download /product.jsp?s=p&id=TDUN-|
MIEVRT& type=s&dt=DIAGNOSTIC+TOOL| possui ferramentas para ajudar a
converter seu aplicativo:

* MigrateWC pega um JSP .91 ou 1.0 e o converte para um JSP 1.1. Pega também
um Servlet 2.1 e o converte para um Servlet 2.2.

* XMLconvert converte os arquivos de configuragdo XML do formato do Release
3.02x ou Release 3.5x para o do Release 4.0.

Alteracoes Internas da Versao 4.0.3

As Dependéncias de Projetos Circulares Nao Serao
Compiladas por Padrao

Se seus projetos tiverem dependéncias circulares, a Versdo 5 relata um erro de
construgdo. Vocé pode entrar em Window > Preferences > Java > Compiler,
selecionar a guia Build Path e limpar a caixa de op¢des Abort building on build
path errors.Observe que isso ndo causard mais a interrupgdo da construcdo, mas
ainda haverd um ou mais erros de ‘dependéncia circular’ de constru¢do mostrados
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na exibi¢do Task (mesmo quando a construgdo for bem-sucedida). Nesse caso, vocé
pode transformar esses erros em avisos selecionando a guia Other e alterando a
preferéncia no menu drop down Circular Dependencies.

Os Projetos da Web da Versao 5 Sao de Localizacao de
Origem Compativel com a Versao 4.0.3

No IBM WebSphere Studio Site Developer Versao 5, ha alteragdes de estrutura do
projeto interno da Versdo 4.0.3. Um WAR da Web do J2EE 1.2 da Versao 5, quando
exportado com a origem Java, serd importado para o IBM WebSphere Studio Site
Developer Versdo 4 e a pasta do cédigo fonte sera automaticamente convertida
para o nome correto e estard apta a construir. O projeto da Web ainda é executado
corretamente no WebSphere Application Server Versdo 4 da mesma maneira
quando um projeto da Versdo 4 é importado para a Versdo 5, porque a pasta do
cédigo fonte é automaticamente convertida para o nome correto. Para obter
informacdes adicionais sobre alteracbes de nome da pasta, consultel”Estruturas da
[Projetos da Web do IBM WebSphere Studio Site Developer” na pagina 29

Nota: A afirmagdo acima ndo serd verdadeira se os projetos da Web forem
compartilhados entre as Versdes 5 e 4 através de um sistema SCM (Software
Configuration Management). Os projetos da Versdo 4 precisam ser migrados
para a estrutura de projetos da Versdo 5 e ndo podem ser carregados de
volta para a Versdo 4 a partir de um sistema SCM depois de migrados.

Estruturas de Projetos da Web do IBM WebSphere Studio Site
Developer

A estrutura interna do projeto da Web no IBM WebSphere Studio Site Developer
Versdo 5 é diferente da do IBM WebSphere Studio Site Developer Versao 4.0.x. Essa
diferenca ndo esta relacionada ao J2EE 1.2 versus J2EE 1.3, mas é uma alteracdo na
utilizacdo da ferramenta.

Na Versao 4, os projetos da Web eram projetos da Web dindmicos por padrao e
apareciam na exibigdo Navigator com uma pasta source e uma pasta
webApplication. Na Versdo 5, se vocé criar um projeto da Web dinamico, ele
aparecera com uma pasta Java Source em vez de uma pasta source e uma pasta
Web Content em vez de webApplication.

No entanto, se um projeto da Web da Versao 4 for salvo e um repositério SCM e,
em seguida, carregado na Versao 5, ele manterd a estrutura antiga com as pastas
origem e webApplication. Qualquer uma das duas estruturas ird construir
corretamente na Versao 5.

Projetos da Web Estaticos versus Dinamicos

Na Versao 5, vocé pode criar projetos estaticos, assim como projetos da Web
dinamicos.

Projetos da Web estaticos contém apenas recursos estaticos como HTML, Java
Scripts, imagens, texto, etc. e nenhum contetido dindmico. Os projetos da Web
estaticos podem ser executados e servidos por um servidor da Web HTTP
tradicional e ndo precisam de um Servidor de Aplicativos da Web.

Os projetos da Web dindmicos contém recursos J2EE dinamicos como servlets, JSPs,
filtros e metadados associados, além dos recursos estaticos. Ao criar projetos da
Web dinamicos, vocé pode incluir paginas em estilo cascata e bibliotecas de
marcagdo JSP, para poder comecar o desenvolvimento com um conjunto mais rico
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de recursos de projetos. Projetos da Web dindmicos estao sempre incorporados nos
projetos do Enterprise Application e sdo executados somente nos Servidores de
Aplicativos da Web.

Distincoes entre HTML e JSP

* Na Versdo 4.0.x, os arquivos HTML e os arquivos JSP eram tratados de forma
idéntica pelo Page Designer. Por exemplo, vocé podia ter marcagdes JSP em um
arquivo HTML. Isso ndo ocorre mais: neste release, ha uma distingdo entre os
arquivos JSP e HTML, portanto vocé ndo pode mais ter marcagdes JSP em um
arquivo HTML.

* A distingdo anterior afeta a codificacdo de arquivos JSP que nédo estdo em inglés.
Em versdes anteriores a este release, eram utilizadas regras de codificacdo
HTML, mesmo para arquivos JSP, para determinar a codificagdo nomeada em
um arquivo. Ou seja, o atributo tipo de conteido da marcagdo meta foi
verificado em (<META http-equiv="Content-Type" content="text/html;
charset=UTF-8">). Nesta versao, isso foi alterado para utilizar as regras de
codificacdo do JSP, para determinar a codificagdo denominada em um arquivo
JSP. Ou seja, a pagina diretriz do arquivo JSP é vista em (<%@page
contentType="text/html;charset=UTF-8"%>). Para arquivos HTML, a codificagdo
permanece inalterada em relagdo as versdes anteriores.

Migrando Projetos Utilizando um Sistema SCM (Software Configuration
Management)
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Migrando Projetos Utilizando CVS ou Rational ClearCase

Essa é a forma recomendada para mover espacos de trabalho da Versdo 4.0.x para

o IBM WebSphere Studio Site Developer Versao 5. Esse é o tinico método que

migra todas as informacdes, incluindo as informag¢des do caminho de construcao

do projeto.

1. Como uma precaugdo de backup, salve todos os projetos da Versao 4 em seu
repositério SCM. Em seguida, consolide (libere) as alteragdes pendentes.

2. Se quiser trabalhar na Versdo 4 e Versdo 5 do IBM WebSphere Studio Site
Developer, salve seu trabalho novamente em uma nova ramifica¢do (fluxo) da
Versao 5. Essa € a ramificagdo que sera utilizada quando vocé for trabalhar com
a Versao 5.

3. Instale a Versdo 5.

4. Feche o IBM WebSphere Studio Site DeveloperVersao 4 e inicie o IBM
WebSphere Studio Site Developer Versao 5.

Dica: Na Versao 4, o diretério da area de trabalho esta localizado no diretorio
de instalagdo, por padrdo. Na Versdo 5, o padrdo mudou para um diretério
denominado workspace no diretério My Documents. Para substituir a
localizacdo onde seu trabalho estd armazenado, utilize a opgdo -data no
comando quando iniciar o workbench.

Nota: Nao utilize -data para apontar para uma drea de trabalho existente da
Versdo 4 visto que esta é uma abordagem diferente, ndo suportada para

migracdo. (Para obter informacdes adicionais, consulte |“Migrando|

Projetos Utilizando um Espaco de Trabalho Existente da Versao 4.0.x” na|

pagina 33).

5. Desative Windows > Preferences > Workbench > Perform build automatically
on resource modification (para evitar erros de construgao a medida que
projetos dependentes individuais sdo carregados).
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6. Para CVS: Carregue todos os projetos com os quais deseja trabalhar a partir do
repositério SCM no IBM WebSphere Studio Site Developer Versao 5.

Para ClearCase: Utilize um espaco de trabalho limpo da Versdo e para cada
projeto selecionado para ser carregado, selecione File > Import > Existing
WebSphere Studio 4.x ClearCase Project into Workspac.

7. Restaure sua definicdo desejada para Windows > Preferences > Workbench >
Perform build automatically on resource modification.

8. Altere o nome da pasta source de source para Java Source e da pasta
webApplication para Web Content para os projetos da Web, se for necessaria
uma construgdo completa. Caso contrdrio, a estrutura antiga das pastas sera
mantida e os projetos da Web nido serdo reconstruidos completamente.

9. Faga uma reconstrucdo completa (Project > Rebuild all) e salve os projetos
resultantes de volta no depdsito de seu novo fluxo da Versao 5. (Nio misture
esses recursos com seu fluxo atual da Verséo 4).

Nota: Estes projetos agora sdo projetos da Versdo 5 e ndo podem ser utilizados
pelo IBM WebSphere Studio Site Developer Versao 4.0.x.

Consideragdes Pés-migracao:

* No IBM WebSphere Studio Site Developer Versao 4.0, os arquivos em um projeto
foram armazenados no formato bindrio no CVS. No formato bindrio, os retornos
de carro/avangos de linha em arquivos nio sdo traduzidos para uso em outras
plataformas e ndo podem ser reconhecidos nos ambientes das plataformas
UNIX®/Linux. Se estiver trabalhando em ambientes de plataformas mistas, por
exemplo, DOS/Windows e UNIX/Linux, convém marcar os arquivos de origem
como texto (utilizando Team > CVS > Change ASCII/Binary Property) e
salva-los novamente no CVS.

* Os projetos da Web da Versao 4 de um repositério de CVS requerem que a
definicdo Window > Preferences > Team > CVS > Prune empty directories seja
desativada (o padrdo é que esteja ativada). Se ndo for desativada e vocé carregar
um projeto da Web com uma pasta source vazia (como no exemplo da Web
MyHomePage), vocé receberd os seguintes erros na hora de registrar entrada:
The project was not built since it is involved in a cycle or has classpath
problems.

Missing required source folder: /MyHomePageExample403/source.

* Para projetos da Web salvos e carregados a partir do repositério ClearCase, serd
necessario registrar saida de um arquivo, antes de poder abri-lo no editor. Se sua
saida ndo tiver sido registrada, vocé recebera erros error activating this view
(Excegdo do ponteiro Null em logs para o Page Designer).Com um editor .xml,
para editar um arquivo web.xml é necessario registrar saida do web.xml,
ibm-web-bnd.xmi e ibm-web-ext.xmi. (H4 indica¢des de que é necessario
registrar saida desses arquivos na linha de status, que estabelece que eles sao
apenas para leitura, mas eles sdo facilmente ignorados).

* Se seus projetos tiverem dependéncias circulares, a Versao 5 relata um erro de
construgdo. Vocé pode entrar em Window > Preferences > Java > Compiler,
selecionar a guia Build Path e limpar a caixa de op¢des Abort building on
build path errors.

* Os arquivos .vem_meta (ou .cc_meta) poderiam ser excluidos agora do projeto
da Versdo 5, pois eles ndo sao utilizados pela Versao 5 (este utiliza uma novo
arquivo .project) e por estar utilizando um novo desvio (fluxo) de depésito para
estes projetos da Versdo 5. Observe que estes arquivos ainda sdo necessarios no
desvio (fluxo) da Versao 4 atual.
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Remocao Pés-migracao das Referéncias de Caminho
Absoluto do EAR e do Servidor de Configuracao

Os arquivos de extensdo do aplicativo da Versdao 4 do EAR IBM e os arquivos de
configuracdo do servidor continham referéncias a caminhos absolutos. Apés a
migracdo destes para a Versdo 5, é necessario abri-los com seu editor (o qual
automaticamente alterard suas referéncias de caminho absoluto anteriores as novas
referéncias relativas).

1. Para cada projeto EAR, em uma Exibicdo Navigator, clique com o botdo direito
do mouse em META-INF/application.xml > Open with > Deployment
Descriptor Editor.

a. Uma janela de didlogo aparece com a mensagem:

The IBM extensions file contains deprecated absolute paths.
This can be auto-corrected and should be saved. This will
remove the paths from the file, and only needs to be done once.
Would you 1like to autocorrect?

b. Clique em Yes.

C. Salve e, em seguida, feche a janela do editor.

Nota: Como alternativa, vocé pode utilizar o assistente para Migragdo J2EE
para migrar a estrutura de projetos apenas para um projeto EAR.
Para acessar o assistente J2EE Migration, clique no projeto EAR com
o botdo direito do mouse e selecione Migrate > J2EE Migration
Wizard.
2. Para cada configuragdo do Servidor, em uma Perspectiva Server, Exibigdo
Server Configuration, clique com o botdo direito no servidor e selecione Open.

a. Sera obtido um didlogo de autocorregao similar.
b. Clique em Yes.
c. Salve e, em seguida, feche a janela do editor.

Migrando Projetos Utilizando Outros SCMs

Ha outros fornecedores SCM que oferecem plug-ins SCM para o IBM WebSphere
Studio Site Developer. Vocé pode procurar na lista de fornecedores

fwww.ibm.com /software /ad /studioappdev /partners/scm.htmllComo parte de sua
validacdo do [Ready for IBM WebSphere Studio software|
[www.developer.ibm.com/websphere/ready.html], todos os fornecedores SCM que
forneceram um plug-in da Versdo 4 terdo assegurados o funcionamento das etapas
de migracdo precedentes (salvas da Versdo 4 para o repositério SCM, carregadas
do repositério para a Versao 5) em seus sistemas.

Migrando os Projetos por Exportacao e Migracao
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1. No IBM WebSphere Studio Site Developer Versao 4.0.x, exporte seus projetos
para um arquivo WAR, um arquivo EAR ou um arquivo JAR (File > Export).

2. No IBM WebSphere Studio Site Developer Versdo 5, importe seu arquivo WAR,
um arquivo EAR ou um arquivo JAR (File > Import).

Nota: Essa ndo é uma migracdo completa, j4 que nenhuma informagao do caminho
de construgdo do projeto é mantida.
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Migrando Projetos Utilizando um Espaco de Trabalho Existente da

Versao 4.0.x

Essa abordagem é parcialmente suportada e resultard em uma migracao
incompleta. As defini¢des da interface com o usudrio, as defini¢cdes de depuracdo e
a maioria das preferéncias sdo todas perdidas. Os nomes de projeto, os arquivos de
origem do projeto e o caminho da construcdo Java do projeto (classpath) sdo
retidos, mas nada mais pode ser garantido. Essa abordagem deve ser utilizada
apenas se nenhum sistema SCM suportado estiver sendo utilizado e se for critico
reter informagdes do caminho de construgao do projeto, que sdo perdidas quando
vocé importa projetos que foram exportados da Versao 4. Vocé pode utilizar a area
de trabalho existente da Versdo 4.0.x, fazendo o seguinte:

1. Consolide (libere) as alteragdes pendentes para o repositdrio.

2. Feche todas as perspectivas e encerre o IBM WebSphere Studio Site Developer
Versao 4.

3. Faga backup do contetido do workspace_directory, em que workspace_directory é
o nome completo do diretério que contém a area de trabalho da Versao 4.0.x.
Por padrao, o subdiretério da area de trabalho da Versdo 4.0.x esté localizado
no mesmo diretério onde o produto estd instalado. Esse backup sera
necessdrio, se algum dia vocé quiser trabalhar com o IBM WebSphere Studio
Site Developer Versdo 4.0.x novamente. Depois de apontar para um espago de
trabalho da Versdo 4.0.x a partir de um IDE da Versdo 5, ndo podera mais
voltar a utilizar o espago de trabalho no IBM WebSphere Studio Site
Developer Versao 4.0.x.

4. Instale o IBM WebSphere Studio Site Developer Versao 5.

5. Ao iniciar o IBM WebSphere Studio Site Developer Versdo 5 com um espaco
de trabalho da Versdo 4.0.x em um prompt de comandos (ou seja, utilizar a
opcdo -data para especificar um caminho completo para o diretério do espaco
de trabalho da Versao 4.0.x no comando ), isto causara um upgrade das
informagdes do .metadata.

6. Quando solicitado a confirmar se deseja converter para o novo formato de
interface com o usudrio, clique em OK.

7. Antes de fazer reconstrugdes ou validar projetos que estdo na drea de trabalho,
selecione todos os projetos da exibi¢do Navigator da perspectiva Resource e,
em seguida, selecione Refresh no menu pop-up. Isso ird assegurar que todos
0s arquivos estejam sincronizados com seus metadados apropriados.

8. Abra os projetos fechados (veja os problemas conhecidos abaixo).
9. Verifique as variaveis do classpath (veja os problemas conhecidos abaixo).

10. Alguns construtores e autenticadores foram incluidos, removidos ou
modificados nesta Versdo 5. Para assegurar que os erros e avisos corretos
sejam exibidos, vocé deve reconstruir todos os projetos, selecionando Project >
Rebuild All e, em seguida, selecionando Run Validation para cada projeto
Java.

11. Algumas preferéncias de usuario podem ser mantidas, mas muitas outras nao
serdo. Verifique as defini¢cdes de suas preferéncias na Versdo 5, para
certificar-se de que elas estejam como vocé deseja.

Remocao Pdés-migracao das Referéncias de Caminho
Absoluto do EAR e do Servidor de Configuracao

As instrucdes sobre pés-migracio descritas em [“Remocio Pos-migracio dag
Referéncias de Caminho Absoluto do EAR e do Servidor de Configuracao” nal
pagina 32| também se aplicam aqui.
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Problemas e Limitac6es Conhecidos

Os problemas a seguir podem ocorrer, se vocé tentar migrar abrindo um espaco de
trabalho da Versao 4.0 no IBM WebSphere Studio Site Developer Versao 5.

Valor Incorreto na Variavel de Caminho da Classe JRE_LIB
Para redefinir a variavel de classpath JRE_LIB para uma localiza¢do valida, siga
estas etapas. Faga isso mesmo se o valor parecer correto, quando abrir a janela
Preferences pela primeira vez.

1. Selecione Window > Preferences > Java > Installed JREs.

2. Na lista, selecione a caixa de opg¢des para a localizagdo padrdo do JRE para a
qual deseja definir seu JRE_LIB.

3. Escolha Edit, e, em seguida, clique em OK para fechar a caixa de didlogo Edit
JRE.

Se vocé ndo fizer isso, o valor de JRE_LIB poderéd estar incorreto, causando muitos
erros de construgdo nos arquivos Java.

Como verificagdo geral, verifique o valor de todas as outras varidveis de classpath.

Em Projetos do SCM Compartilhados Anteriormente, o Menu
Equipe Contém Compartilhar Projeto

O suporte para equipe foi alterado de forma significativa entre o Eclipse 1.0 e 2.0.
O método de compartilhamento de projetos com o repositério também foi alterado.

* Se vocé clicar com o botdo direito no projeto e, em seguida, selecionar a opgdo
Team > Share Project, um assistente ira guid-lo pelo processo de migragéo.
Quando tiver terminado, seu projeto estard compartilhado e a exibicdo
Synchronize abrird. Vocé vera alteragoes conflitantes em todos os arquivos. Isso é
devido as altera¢Ges na maneira como as informagdes sobre sincroniza¢do sao
armazenadas entre o Eclipse 1.0 e 2.0.

* Se ndo houver alteragdes de transmissdo (que ndo devem existir se vocé tiver
consolidado todas as suas altera¢des de transmissao antes de efetuar upgrade,
conforme recomendado acima), entdo, vocé poderd simplesmente selecionar o
projeto na exibicdo Synchronize e selecionar Override and Update que ird
carregar o contetido atual do servidor.

* Se vocé tiver alteragdes de transmissao, podera selecionar o menu em tridangulo
na exibi¢do Synchronize e selecionar Compare File Contents. Depois de algum
trabalho, a exibigdo Synchronize ird exibir apenas os arquivos que sdo realmente
diferentes. Vocé podera, entdo, utilizar a exibi¢do Synchronize, para resolver
esses conflitos.

Projetos Criados Fora do Diretério do Espaco de Trabalho
Por padréo, os projetos sdo criados no diretério da area de trabalho. Se vocé tiver

substituido o padrdo para criar projetos em outro lugar, abra todos os seus projetos
antes de fechar o workbench. Isso permitird que o arquivo .project para aquele
projeto seja gravado na localizacdo correta. Falhar em abrir um projeto fechado
cujo diretdrio esta fora da drea de trabalho resultard em um projeto que mascara o
projeto real, com apenas um arquivo .project existente nele.

Os Pontos de Interrupcao do JSP Devem ser Redefinidos
Serd necessério remover os pontos de interrupcdo JSP existentes e redefini-los na
area de trabalho migrada da Versao 5.
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Migrando Dados Relacionais nos Projetos da Web de 4.0.3

Para migrar dados relacionais de projetos do IBM WebSphere Studio Site
Developer 4.0.3:

1. A partir de um espago de trabalho do IBM WebSphere Studio Site Developer
4.0.3, gere os arquivos DDL para cada banco de dados disponivel.

2. Remova o banco de dados da origem/bancos de dados do Projeto da Web (por
meio da exibi¢do Data Definition).

3. Abra o espago de trabalho 4.0.3 com o IBM WebSphere Studio Site Developer
Versao 5.

4. Migre os projetos da Web para os quais vocé deseja restaurar os dados
relacionais.

5. Clique em File > Import > File System e especifique os arquivos DDL de seu
espago de trabalho do 4.0.3.

6. Na exibicdo Data Definition da perspectiva Data, selecione Run against Local e
especifique o projeto de destino da Web.

Os artefatos de dados relacionais serdao restaurados.

Erros WSDL Apés a Importacao de um Arquivo de Servicos da
Web de 4.0.x

Se vocé importou um arquivo de servicos da Web do 4.0.x, é possivel que vocé
receba as seguintes mensagens de erro:

Error The part 'result' has an invalid value 'anyElement'
defined for its type. Type declarations must refer to
valid values defined in a schema.

Error The part 'return' has an invalid

value 'findPatientResult' defined for its element.
ETement declarations must refer to valid values
defined in a schema.

Error The part 'response' has an invalid

value 'findPatientResponse' defined for its element.
Element declarations must refer to valid values
defined in a schema.

A solucdo alternativa é:
1. Excluir os arquivos do WSDL.

2. Gerar seus servicos da Web novamente, reexecutando o assistente Web Services.

Migrando Estruturas de Projetos do J2EE e/ou Niveis de Especificacao
do J2EE

Para acessar o assistente J2EE Migration na Versdo 5, siga as etapas abaixo:
1. Selecione o projeto.

2. Clique nele com o botdo direito do mouse e selecione Migrate > J2EE
Migration Wizard. Siga as etapas do assistente para ser orientado na migragao.

3. Se o projeto estiver sob controle de origem, entdo salve o projeto reestruturado
em seu SCM.
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Capitulo 6. Migrando do WebSphere Studio "Classic” para o
IBM WebSphere Studio Site Developer

Este capitulo documenta como migrar do WebSphere Studio Versdo 4.0 (Advanced
e Professional Edition) para o IBM WebSphere Studio Site Developer. Migrar do
WebSphere Studio "Classic” Versdo 4.0 para o IBM WebSphere Studio Site
Developer Versao 5.0 envolve as seguintes etapas:

1. Criar um novo estdgio de servidor tinico para migracéo.
2. Criar um arquivo do descritor de configuracdo da Web.
3. Exportar um arquivo JAR de migragao.
4

. Importar o arquivo JAR de migracdo para o IBM WebSphere Studio Site
Developer.

5. Configurar seu servidor e testar o seu aplicativo migrado.

Nota: As instrugdes a seguir sdo para a migracdo a partir do WebSphere Studio
Versdo 4.0. Se desejar migrar de uma versdo anterior do WebSphere Studio,
deverd primeiramente migrar para o WebSphere Studio 4.0, em seguida,
para o IBM WebSphere Studio Site Developer.

O recurso de publicagdo avancada (mapeamento de arquivos para estagios de
publicagdo) e o recurso Page Detailer (andlise de paginas da Web) do WebSphere
Studio ’Classic’ ndo estdo disponiveis no IBM WebSphere Studio Site Developer.
Alguns outros recursos do pacote de midia do CD da Versao 4.0.x também ndo
estdo mais disponiveis. Por exemplo, o recurso Page Detailer para anélise de
paginas da Web, o recurso HotMedia® para tipos rich media, o editor Voice XML
(movido para o WebSphere Everyplace " Toolkit e o Portal Toolkit),
DataBaseWizard para dispositivos interativos.

E recomendaével ter conhecimento das seguintes limitagdes antes de migrar
quaisquer de seus dados do WebSphere Studio:

* O IBM WebSphere Studio Site Developer utiliza um editor SQL com base em
XML, de modo que os arquivos .sql ndo podem ser utilizados no mesmo.

* A publica¢do de projetos e informagdes sobre estdgio ndo podem ser migradas.

* As informagdes sobre configuragdo do servidor do WebSphere Studio ndo
podem ser migradas.

* As informagbes sobre controle de versao ndao podem ser migradas.

Durante o processo de migracdo descrito abaixo, o WebSphere Studio cria um
arquivo JAR que contém todos os seus arquivos de projeto, publicéveis e de
origem, de um tnico servidor. Todos os arquivos visiveis na exibigdo Publishing do
servidor padrdo estardo em um pacote dentro do arquivo JAR. Em seguida, é
possivel importar o arquivo JAR para o IBM WebSphere Studio Site Developer.

Ao migrar projetos existentes, todas as informagdes sobre publicacao do projeto e
de estagio sdo perdidas durante a migracdo. Se o seu estagio tiver varios
servidores, serdo conservados apenas os arquivos publicados no servidor padrao.
Dessa forma, para finalidades de migracdo, vocé deverd criar um novo estagio que
tenha apenas um servidor.
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Criando uma Nova Etapa de Servidor Unico para Migracao

Se vocé tiver mais de um servidor no seu estagio atual, crie um novo estagio
chamado Migration com um tnico servidor perfazendo as seguintes etapas:

1.

ok 0N

N o

Clique em Project > Customize Publishing Stages.

Digite Migration no campo Stage name.

Clique em Add.

Clique em OK.

Clique em Project > Publishing Stage e selecione Migration a partir da lista de
estagios disponiveis.

Na exibigao publishing, clique em Insert > Server.

Digite um nome de servidor, tal como Tocalhost.

A alteracdo do servidor ou do estagio de publicagdo ndo propaga as
informagdes sobre mapeamento do servlet do WebSphere Application Server
Versao 4.0. V4 para a exibigdo Publishing e, para cada servlet, clique em
Properties > Publishing > Servlet Mapping e, em seguida, copie o
mapeamento atual de servlet.

Criando um Arquivo Descritor de Configuracao da Web

1.

2.
3.
4.

Na exibigdo project file, clique em Project > Create Web Configuration
Descriptor File.

Selecione todos os servlets necessarios.
Selecione todos os arquivos TLD (Tag Library Descriptor).
Clique em Create.

O nome do arquivo do descritor de configuracdo da Web padrao é
serverName_web.xml, localhost_web.xml neste cenario. A menos que vocé
especifique uma localiza¢do diferente, o arquivo .xml serd salvo no diretério
WEB-INFE.

Exportando um Arquivo JAR de Migracao

1.

7.

Na exibigdo Project File, selecione o servidor localhost e clique em Properties >
Publishing > WebApp Web Path e insira um caminho da Web (raiz do
contexto), tal como myWebPath. Isto também sera utilizado como o nome do
projeto do WebSphere Application Server - Express.

Na exibigdo project file, selecione Project > Create Migration file.
Verifique se localhost é o servidor selecionado.

Verifique se localhost_web.xml é o arquivo do descritor de configura¢ao da
Web selecionado.

Clique em OK.

O nome do arquivo JAR padrao neste cenario é serverName.jar, localhost.jar.
Renomeie o arquivo, se desejar.

Salve o arquivo JAR.

Importando o Arquivo JAR de Migracao para o IBM WebSphere Studio

Site Developer

1.
2.

Inicie o IBM WebSphere Studio Site Developer.
Crie um projeto da Web (File > New > Project > Web Project).
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3. No campo Project name, digite o0 nome de seu projeto da Web. Deve ser o
mesmo nome especificado na etapa 1 da segéo [“Exportando um Arquivo JAR|
[de Migracdo” na pagina 3§ precedente.

4. Especifique o nome de um novo projeto EAR ou de um projeto existente que
ird conter o novo projeto da Web, para finalidades de implementagao.

5. No campo Context Root, digite 0 nome Webapp Web Path que especificou ao
criar o arquivo JAR de migracdo no WebSphere Studio. Clique em Finish.

6. Na exibicdo Navigator, selecione o projeto da Web que acabou de criar.
7. Importe o arquivo JAR.
a. Clique em File > Import.

b. Clique em WAR file. Clique em Next. O arquivo JAR deve ser importado
com a op¢do WAR File; de outra maneira ele ndo funcionara corretamente.

c. Digite o caminho para localhost.jar no campo WAR File ou clique em
Browse para pesquisa-lo. (Somente é possivel procurar por um nome .WAR
e ndo por um .JAR).

d. Selecione o projeto da Web existente que vocé criou. O campo Context Root
é preenchido automaticamente com o valor especificado anteriormente.

e. Clique em Finish. Aparece um didlogo perguntando "Resource
WEB-INF/web.xml already exists. Would you Tike to overwrite it?".

f. Selecione Yes e IBM WebSphere Studio Site Developer descompacte
localhost jar.

8. Poderdo haver diversas referéncias nao resolvidas ou arquivos de importagado
ausentes. Todos irdo aparecer na exibi¢do Tasks. Para corrigir este problema, o
caminho de construcdo Java deve ser modificado para o projeto da Web:

a. Clique com o botdo direito do mouse no projeto e clique em Properties >
Java Build Path.

b. Clique na guia Libraries. Clique em Add External JARs.
c. Importe os JARs necessdrios dos seguintes diretérios:

¢ WS_Installdir/runtimes/aes_v4/lib e

¢ WS_Installdir/runtimes/base_v4/lib

9. Na exibicdo Navigator, clique com botédo direito do mouse no projeto e
selecione Rebuild Project.

Testando o Aplicativo Migrado em um Servidor de Teste

Agora vocé estd pronto para testar seu aplicativo. Para testa-lo no servidor de
testes padrao, siga estas etapas:

1. Clique com o botdo direito no projeto EAR.
2. Selecione Run on Server

Para testar seu aplicativo em outros ambientes em tempo de execugdao do servidor,
consulte a ajuda on-line do recurso Server Tools.
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Capitulo 7. Migrando do VisualAge para Java para o IBM
WebSphere Studio Site Developer

Este capitulo documenta como migrar do VisualAge® para Java, Professional
Edition ou VisualAge para Java Enterprise Edition para o IBM WebSphere Studio
Site Developer.

Nota:

Nota:

As instrucdes dadas neste capitulo sdo para a migracdo do VisualAge para
Java Versdo 3.5.3 ou 4.0 para Windows. Se quiser migrar de uma versdo
anterior do VisualAge para Java para o IBM WebSphere Studio Site
Developer, vocé devera primeiro migrar de sua versdo anterior do
VisualAge para Java para a da Versdo 3.5.3 ou 4.0 para Windows, antes de
migrar para o IBM WebSphere Studio Site Developer.

A [nstantiations, Inc., um Parceiro IBM, distribui um produto,
denominado CodePro Studio que fornece aperfeicoamentos de
produtividade para o VisualAge para Java e o WebSphere Application Server
- Express, incluindo recursos de migracdo e coexisténcia. Para auxiliar os
clientes do VisualAge para Java a iniciar a migracdo, a Instantiations estd
oferecendo utilizagdo gratuita e ilimitada do recurso de exportagdo do
VisualAge para Java para o IBM WebSphere Studio Site Developer como
parte de sua cépia para avaliagdo por tempo limitado do CodePro Studio.
Vocé pode fazer download da cdpia avaliacdo no endereco
[www.instantiations.com /vaj-migrate| Para obter informacoes adicionais
sobre o suporte de coexisténcia e migracdo avangado no Instantiation,
incluindo a exportacdo/importacdo bidirecional completa de arquivos,
criagdo de defini¢des de exportacdo/importacao, sincronizacao de projetos e
automacao de tarefas, procure a Instantiations, Inc. no
enderecqwww.instantiations.com /codepro/ws|

Diferencas entre VisualAge para Java e IBM WebSphere Studio Site

Developer

A seguir, uma lista parcial das alteragoes do VisualAge para Java:

* O nivel de especificacdo do EJB (Enterprise Java Beans) mudou de 1.0 para 1.1
(EJB 2.0 também ¢é suportado para aplicativos que serdo implementados para o
WebSphere Application Server Versao 5).

* Para aplicativos da Web, o nivel JSP permanece 1.1 (1.2 para aplicativos do
WebSphere Application Server Versao 5).

* Para aplicativos da Web, o nivel de Servlet permanece 2.2 (2.3 para aplicativos
do WebSphere Application Server Versao 5).

* O nivel da plataforma Java 2 suportado mudou de 1.2 para 1.3. (O compilador
pode ter como destino geracdo de cédigo 1.4, mas o ambiente de tempo de
execugdo do WebSphere Application Server ainda é 1.3).

* O Visual Composition Editor foi substituido pelo Visual Editor para Java.

* O controle de versao e o repositério de codigo de origem de propriedade do
VisualAge para Java foram substituidos pelo suporte para plug-ins de
gerenciamento de SCM (Software Configuration Management).

* A API das Ferramentas do VisualAge para Java foi substituida pela arquitetura
de plug-in de Workbench do WebSphere Studio.
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* As ferramentas XML do VisualAge para Java foram substituidas por ferramentas
XML do IBM WebSphere Studio Site Developer.

* O conceito de projeto do VisualAge para Java foi substituido por varios tipos de
projetos do IBM WebSphere Studio Site Developer.

Migrando do VisualAge para Java

42

As etapas a seguir delineiam como migrar do VisualAge para Java. Sdo fornecidos
abaixo detalhes sobre a execugdo de tais etapas:

1. |[Exportando seus Arquivos Java e Arquivos de Recursos do Projeto do|
VisualAge para Javal

2. [Inicie o IBM WebSphere Studio Site Developer e crie novos projetos para conter|
seu codigo|

3. |Importe os arquivos Java e arquivos de recursos de projetos para o IBM]
WebSphere Studio Site Developer|

4. [Utilize o editor web.xml para assegurar que todos os servlets sejam definidos|
corretamente (somente projetos da Web).|

5. [Migre seu projeto e as definicoes de espaco de trabalhol

6. [Configure o servidor e teste o(s) aplicativo(s) migrado(s).|

7. [Implemente os aplicativos do IBM WebSphere Studio Site Developer para o
WebSphere Application Server,|

8. |Compartilhe as definicdes de projetos do IBM WebSphere Studio Site Developer]
entre vérios desenvolvedores (migracio posterior).|

Exportando seus Arquivos Java e Arquivos de Recursos do
Projeto do VisualAge para Java

Nao ha suporte para a migragdo em massa de projetos e recursos em versdo do
repositério do VisualAge para Java. E possivel migrar apenas projetos e recursos
que estdo na area de trabalho do VisualAge para Java. Se quiser migrar uma copia
transformada em versdo de um projeto ou recurso para o IBM WebSphere Studio
Site Developer, devera trazé-la para o espaco de trabalho do VisualAge para Java e,
em seguida, migra-la.

Nota: Se seu projeto contém mais de um tipo de dados (por exemplo, beans
corporativos e arquivos de cédigo fonte do Java), é necessario dividir seus
dados em JARs diferentes, baseados em seus tipos.

Exporte seus projetos para um arquivo JAR, seguindo estas etapas:

1. Se os projetos que deseja exportar ndo estiverem na area de trabalho do
VisualAge para Java, inclua-os agora na area de trabalho.

2. Na janela VisualAge for Java Workbench, selecione seu projeto, clique com o
botdo direito do mouse e clique em Export.

3. Selecione o botdo de opgdes JAR File e clique em Next.
4. Especifique o nome do arquivo JAR.

5. Marque a caixa de opgdes .java para exportar os seus arquivos Java e a caixa de
opgdes resources para exportar seus arquivos de recursos.

6. Preencha adequadamente os outros campos. Consulte a ajuda on-line do
VisualAge para Java para obter informagdes adicionais sobre como executar
esta tarefa.
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Iniciando o IBM WebSphere Studio Site Developer e Criando
Novos Projetos para Conter o Cédigo

Inicie o IBM WebSphere Studio Site Developer, em seguida, crie os projetos
apropriados. A seguir encontra-se um conjunto de diretrizes gerais de migracdo
para ajuda-lo a decidir a que tipo de projeto do IBM WebSphere Studio Site
Developer vocé deve importar seus arquivos:

* Se o seu codigo for parte de um aplicativo da Web, importe o cédigo para um
projeto da Web.

— Importe todos os arquivos Java para o diretério Java Source do projeto da
Web (sera criada automaticamente a hierarquia apropriada com base nas
instrucdes de pacotes pelo IBM WebSphere Studio Site Developer)

— Importe todos os arquivos de recursos para o diretério Web Content do
projeto da Web.

* Se o0 seu c6édigo for puramente Java (por exemplo, um aplicativo de execugao
independente), importe o c6digo para um projeto Java.

Nota: As defini¢des precedentes sdo diretrizes gerais para auxilid-lo a decidir quais
tipos de projetos do IBM WebSphere Studio Site Developer deveria utilizar.
E recomendavel a leitura da ajuda on-line do IBM WebSphere Studio Site
Developer e a familiaridade com os diferentes tipos de projetos do
WebSphere Application Server - Express antes da criacdo de qualquer
projeto ou da importagdo de qualquer codigo.

Importando os Arquivos Java e Arquivos de Recursos para o
IBM WebSphere Studio Site Developer

1. Abra o IBM WebSphere Studio Site Developer e v4 para a perspectiva Resource.
2. Clique em File > Import > Zip file. Clique em Next.

3. Navegue até o arquivo JAR apropriado.
4

. Selecione os arquivos que deseja importar e o projeto ou a pasta que deseja que
seus arquivos contenham.

Nota:

* A importacdo FileSystem também pode ser utilizada no lugar da
importacdo ZIP, mas a importagdo ZIP é utilizada mais comumente. Vocé
pode utilizar as mesmas instrugdes para uma importagdo de arquivo e
apontar para uma pasta em vez de para um arquivo ZIP no assistente File
Import.

* Ao importar seus arquivos no IBM WebSphere Studio Site Developer, é
necessdrio certificar-se que estes estdo sendo colocados no diretério
apropriado. E recomendaével a leitura da ajuda on-line do IBM WebSphere
Studio Site Developer e a familiaridade com os diferentes tipos de
projetos do IBM WebSphere Studio Site Developer antes da importagdo do
codigo. Isso ird ajuda-lo a determinar quais pastas devem conter quais
tipos de codigo.

Utilizando o Editor web.xml para Assegurar que os Servlets
Estao Definidos Corretamente (Somente Projeto da Web)

Se o seu aplicativo usar servlets, serd necessario definir os mapeamentos de
servlet-URL no arquivo web.xml. Execute as seguintes etapas:

1. Na perspectiva Web, abra o arquivo web.xml, que esta localizado no
subdiretério Web Content/WEB-INF do seu projeto da Web.
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Clique na guia Servlets.
Clique em Add e selecione o botdo de opgdes Servlet.
Digite o nome do servlet e clique em OK.

A

Clique em Browse para alterar o valor da Servlet class para o nome
apropriado do pacote.

6. (Opcional) O nome exibido serd um nome abreviado para identificar o servlet.
No campo Display name, digite o0 nome abreviado para o servlet.

7. Um mapeamento da URL define um servlet e um padrdao URL. Clique no botao
Add localizado préximo ao campo URL Mappings e digite o nome do
mapeamento da URL.

8. Salve as alteragdes (File > Save web.xml) e feche o arquivo web.xml.

Migrando Definicoes de Projeto e Espaco de Trabalho

E necessério gravar as seguintes definicdes do VisualAge para Java e configura-las
no IBM WebSphere Studio Site Developer:

* Caminho de classe do projeto
* Associagoes de recursos

* Formatacdo de cédigo

* Configuracao WTE

* Arquivos Java e arquivos de recursos do projeto
Caminho da classe do projeto

No VisualAge para Java, vocé define o classpath do projeto nas paginas Resources
da janela Options (Window > Options > Resources). Depois de migrar seus
projetos para o IBM WebSphere Studio Site Developer, vocé podera configurar o
classpath do projeto na janela Properties do projeto (clique com o botdo direito no
projeto e selecione Properties > Java Build Path. Clique na guia Libraries).
Também é possivel definir variaveis de classpath na janela Preferences (Window >
Preferences > Java > Classpath Variables).

Associa¢oes de Recursos

Se vocé configurar uma associa¢do entre um tipo de arquivo e um executével, de
dentro do workbench podera abrir um arquivo que esteja fora dele.

No VisualAge para Java, vocé configura as associa¢des de recursos na janela
Options (Window > Options > Resources > Resource Associations). Depois de
migrar seus arquivos de recursos para o IBM WebSphere Studio Site Developer,
vocé podera configurar suas associagdes de recursos, utilizando a janela
Preferences (Window > Preferences > Workbench > File Associations).

Formatador de Cédigo

No VisualAge para Java, vocé configura suas op¢des de formatacdo de cédigo na
pégina Formatter da janela Options (Window > Options > Coding > Formatter).
Depois de migrar seu codigo para o IBM WebSphere Studio Site Developer, vocé
podera configurar a formatacdo do c6digo na janela Preferences (Window >

Preferences > Java > Code Formatter).

Configuracao do WTE
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No VisualAge para Java, as defini¢coes de tempo de execugdo do Ambiente de Teste
da Unidade WebSphere e do WebSphere Application Server estdo em varios
arquivos de propriedades no seguinte diretdrio:

VisualAgelnstalldir\ide\ project_resources\IBM WebSphere Test
Environment\properties, onde VisualAgelnstalldir é o seu diretério de instalagdo do
produto.

Se, por exemplo, vocé ativou o URL regravando no arquivo de propriedade
session.xml, alterando a propriedade para true como demonstrado a seguir,
<url-rewriting-enabled>true</url-rewriting-enabled>, podera configurar essa
propriedades no Ambiente de Teste do IBM WebSphere Studio Site Developer
Versdo 4.0. (Na perspectiva Server, abra a exibi¢do Server Configuration, clique
com o botdo direito no servidor com o qual deseja trabalhar e clique em Open.
Clique na guia Web e selecione a caixa de opcdes Enable URL rewrite).

Arquivos Java e Arquivos de Recursos do Projeto

O arquivo de propriedades default.servlet_engine contém o <root-uri> da raiz de
contexto do(s) aplicativo(s) da Web do VisualAge para Java. Ao criar um Projeto da
Web no IBM WebSphere Studio Site Developer, o didlogo Create a Web Project
contém um campo Context root para esses dados.

As definigdes do aplicativo da Web em arquivos como

Visual Agelnstalldir\ide\ project_resources\IBM WebSphere Test
Environment\hosts\default_host\default_app\servlets\default_app.webapp que
vocé mesmo personalizou devem ser migradas para o arquivo
your_Web_project\Web Content\WEB-INF\web.xml no IBM WebSphere Studio Site
Developer. Por exemplo, se foram modificados nomes e caminhos de servlets no
arquivo default_app.webapp, € necessario fazer as alteragdes correspondentes no
arquivo web.xml.

Configurando o Ambiente de Teste do WebSphere V4 e
Testando o(s) Aplicativo(s) Migrados(s)
Se o aplicativo for um projeto Java, apenas utilize o suporte normal de projetos
Java do IBM WebSphere Studio Site Developer Run ou Debug para testa-lo.

Se o aplicativo utilizar o WebSphere Application Server , teste-o usando o
WebSphere Application Server interno. Isto requer a criagdo e a inicializacdo de um
servidor de testes padrdo. Em um projeto da Web, clique com o botdo direito do
mouse na pagina HTML principal e selecione Run on Server para ativar o
navegador da Web.

Para obter informacdes sobre o teste de outros tipos de projetos, consulte a ajuda
on-line.

Implementando Aplicativos do IBM WebSphere Studio Site
Developer para o WebSphere Application Server Remoto

Se estiver utilizando o WebSphere Application Server como ambiente em tempo de
execucdo, implemente seu aplicativo utilizando o recurso Server Tools do IBM
WebSphere Studio Site Developer.
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Compartilhando as Definicoes de Projetos do IBM WebSphere
Studio Site Developer entre Varios Desenvolvedores
(Migracao Posterior)
Os projetos do IBM WebSphere Studio Site Developer (e suas defini¢des
associadas) podem ser compartilhados entre desenvolvedores. Para fazer isso, salve
um projeto no servidor do SCM (Software Configuration Management) do IBM

WebSphere Studio Site Developer, em seguida, extraia-o para outro membro da
equipe no IBM WebSphere Studio Site Developer.

Suporte de Equipe no IBM WebSphere Studio Site Developer

Para obter informacdes sobre suporte de equipe no IBM WebSphere Studio Site
Developer Versao 4.0, consulte
www.ibm.com /websphere/developer /library /techarticles /0108_karasiuk /0108_karasiuk.html|

Também hé informacgdes no guia e na ajuda on-line da Instalacdo sobre o suporte
de equipe no IBM WebSphere Studio Site Developer.
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Capitulo 8. Migrando do VisualAge para Java Visual
Composition Editor para o Visual Editor para Java

Este capitulo fornece instru¢des sobre como migrar aplicativos criados no recurso
Visual Composition Editor do VisualAge para Java no Visual Editor para Java no
WebSphere Application Server - Express:

Salvando de metadados aprimorados de tempo de design do VisualAge para

Java

Completando a migracdo (importando no WebSphere Studio)

Salvando Metadados de Tempo de Design Aprimorado do VisualAge

para Java

Esta etapa é opcional, mas altamente recomendada (especialmente se seu aplicativo
possuir conexdes) pelas razoes a seguir.

O VisualAge para Java ndo salvou informagdes sobre o posicionamento de beans
de alto nivel (isto é, as que ndo estdo contidas em outros beans) na superficie de
forma livre. Por outro lado, o WebSphere Studio sempre salva estas informagoes
como um comentdrio na linha de cédigo que declara o bean e restaura-o a esta
posicdo no canvas sempre que o Visual Editor for aberto. Ha a op¢do de salvar
estas informagdes sobre tempo de design no VisualAge para Java antes da
migragdo. Se estas ndo forem salvas, ao abrir pela primeira vez seus arquivos
java no novo Visual Editor para Java, o editor calcula uma posi¢do padrao para
beans de alto nivel (também conhecidos como partes de forma livre), os quais
podem ser facilmente alterados por meio das operac¢des arrastar e soltar.

Embora o novo Visual Editor para Java no WebSphere Application Server -
Express ndo suporte o design de conexdo, é possivel que uma fungao
equivalente possa ser incluida no futuro. (Nota: Isso ndo é um compromisso do
produto, mas apenas uma prepara¢do para uma possibilidade futura).

Para salvar as informagoes dos metadados aprimorados antes da migracdo:

1.

Va4 para o VisualAge para Java Developer Domain
[www.software.ibm.com/vad/data/document4293| e faca download do IBM
VCE Code Generation and Export Ultility.

Seguindo a ferramenta README, inclua a ferramenta no VisualAge para Java
e, depois, interrompa e reinicie o VisualAge para Java.

Versione o cédigo do aplicativo atual no depésito do VisualAge para Java (para
que seja possivel retornar a esta versdo no caso de qualquer desenvolvimento
em andamento do VisualAge para Java).

Para cada um de seus aplicativos graficos no VisualAge para Java, selecione um
ou mais programas graficos (tipicamente XxxxxView), clique com o botao
direito do mouse e, em seguida, faca o seguinte:

a. Clique em VCE Code Generation/Export e deixe selecionada a opgao
Export to a directory after code regeneration.

b. Clique em Finish.
c. Deixe Directory com o destino de exportagdo selecionado e clique em Next.

d. Selecione seu diretério de destino, desmarcando a opgdo .class e
selecionando a opcdo .java (visto que é desejado o codigo fonte), e, em
seguida, clique em Finish.
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e. Opcionalmente, recarregue seu codigo do VisualAge para Java com a versdao
anterior (clique com o botdo direito do mouse e selecione Replace with >
Previous edition).

Concluindo a Migracao (Importando para o WebSphere Studio)

Suas classes estdo prontas agora para serem importadas para o WebSphere
Application Server - Express. Consulte referéncia anterior no |Capitulo 7,|
“Migrando do VisualAge para Java para o IBM WebSphere Studio Site Developer” |
na pagina 41} Depois que os programas de origem anteriores do Visual
Composition Editor forem importados para o WebSphere Application Server -
Express, vocé poderd manté-los no Visual Editor para Java.
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Capitulo 9. Configuracao da Compilacao (Biblioteca, JARs,
JARs Dependentes de Projeto, Compilacoes Ant)

Este capitulo cobre os seguintes topicos de migracao:
* JARS da biblioteca Java e JARs externos de terceiros

¢ Otimizando construgdes de varios projetos, utilizando JARs Dependentes de
Projeto

* Construgdes de produgdo automatizadas, utilizando Ant

JARs da Biblioteca Java e JARs Externos de Terceiros

Para obter explicagdes detalhadas sobre o que estd envolvido, consulte o artigo
sobre J2EE Class Loading Demystified

(www.ibm.com/websphere /developer /library /techarticles /0112_deboer /|
Igleboer.html» (Médulos do J2EE e caminhos de classe) e sobre o desenvolvimento
de JARs do utilitario J2EE

(www.ibm.com /websphere/developer /library / techarticles /0112_deboer/|
Igeboer2.htm |) (JARs do Java em modulos do J2EE). Eles oferecem excelente
conhecimento e aconselhamento técnico.

A Maneira Recomendada de Utilizar um JAR de Terceiros em
um Projeto da Web

A maneira recomendada para utilizar um arquivo JAR de terceiros em um projeto
da Web é importa-lo (mantendo-o como um arquivo JAR) na pasta de bibliotecas
de seu projeto da Web. Esta é a tinica maneira transferivel e definida pelo J2EE
para a utilizagdo de um arquivo JAR e garante que ndo sera necessario fazer
alteracoes ao implementa-lo em outro servidor.

Para utilizar um arquivo JAR externo em um tnico projeto da Web, siga as etapas
abaixo. Se for necessério utilizar o arquivo JAR em um vérios projetos da Web, siga
entdo as etapas descritas em|”A Maneira Recomendada de Utilizar um JAR de|
[Terceiros para Uso em Varios Projetos Web” na pagina 49

1. Selecione File > Import > File System. Clique em Next. E necessério selecionar
File system e ndo Zip file, a fim de assegurar que o arquivo JAR ndo esteja
expandido ao ser importado.

2. Clique em Browse e localize o diretério do arquivo JAR.

3. Importe-o para sua pasta WebProject/WebContent/ WEB-INF/lib, em que
WebProject é o nome de seu projeto da Web.

4. Clique em Finish. O arquivo JAR sera incluido automaticamente no caminho
de construgdo Java e nenhuma outra alteracdo serad requerida no tempo de
execugao.

A Maneira Recomendada de Utilizar um JAR de Terceiros para
Uso em Varios Projetos Web

A maneira recomendada para utilizar um arquivo JAR de terceiros com dois ou
mais projetos do Web é importa-lo (mantendo-o como um arquivo JAR) em um
projeto EAR (Enterprise Application). Esta é a dnica maneira transferivel e definida
pelo J2EE para a utilizagdo de um arquivo JAR e garante que ndo serd necessario
fazer alteragdes ao implementé-lo em outro servidor.
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Para utilizar um arquivo JAR com vérios projetos do Web, siga as etapas a seguir.
Se vocé precisar apenas utilizar o arquivo JAR em um projeto da Web, siga as
etapas na segao anterior.

1. Selecione File > Import > File System. Clique em Next. E necessério selecionar
File system e nao Zip file, a fim de assegurar que o arquivo JAR né&o esteja
expandido ao ser importado.

2. Clique em Browse e localize o diretério do arquivo JAR.

3. Importe o arquivo JAR para o projeto Enterprise Application que contém os
projetos do Web.

4. Clique em Finish. O arquivo JAR sera incluido automaticamente no caminho
de construgdo Java e nédo serdo necessarias altera¢des adicionais durante o
tempo de execugdo.

5. Siga as etapas na segdo seguinte para adicionar o arquivo JAR as dependéncias
do médulo do projeto da Web .

A Maneira Alternativa de Utilizar Arquivos JAR Externos
(Compilacao Global e Classpath do Servidor)

Vocé também pode deixar o arquivo JAR fora do WebSphere Application Server -
Express e adiciond-lo ao caminho de compilagdo de Java e ao caminho da classe da
instancia do servidor. Isto ndo é recomendado porque seu aplicativo ndo serd
transferido com facilidade. Quando for movido para um servidor diferente, serd
sempre necessdrio atualizar o caminho da classe do servidor. Além disso, vocé
precisa assegurar que seus arquivos class nao conflitem com outras versdes de
arquivos class similares que ja se encontram no classpath do servidor (e sdo
necessdrios para o servidor ou seus outros aplicativos). Se vocé decidir utilizar essa
abordagem, execute as seguintes etapas:

1. Inclua o arquivo JAR externo no caminho da classe de construcdo Java do
projeto que requer o arquivo JAR.

a. Selecione o projeto, clique nele com o botdo direito do mouse e selecione
Properties no menu pop-up.

Clique em Java Build Path.

Clique na guia Libraries.

Clique em Add External JARs. Selecione o arquivo JAR e clique em Open.
Clique em OK.

2. Inclua o arquivo JAR externo no caminho da classe da instancia do servidor

® oo o

a. Abra a exibigdo Server Configuration e expanda a pasta Server.

b. Selecione a ocorréncia do servidor no qual o projeto estd implementado.
Clique nele com o botdo direito do mouse e clique em Open.

c. Clique na guia Paths.

d. Em ws.ext.dirs, clique em Add External JARs. Selecione o arquivo JAR e
clique em Open. Observe que o ws.ext.dirs é utilizado para arquivos JAR
de aplicativos e o CLASSPATH é utilizado para arquivos JAR de servidores.

e. Feche a instancia do servidor e salve suas alteragdes.
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Otimizando Compilacoes de Varios Projetos Utilizando JARs
Dependentes de Projeto

O recurso de auto-compilagdo potente do WebSphere Application Server - Express
pode diminuir o desempenho da compilagdo durante compilacdes complexas de
varios projetos. Ha varias maneiras de controlar essas constru¢des automaéticas
(arquivos dependentes, projetos ativos e inativos e projetos em formato de origem
ou JAR), mas estas opgdes podem tornar-se bem complicadas. Ha um artigo que
explica as opgdes e como otimizar o desempenho de sua construcdo. Consulte o
artico do WebSphere Developer Domain '[Optimizing Multi-Project Builds Using|
ldependent Project JARs in WebSphere Studio Application Developer
(www.ibm.com/websphere/developer/library/techarticles /0204_searle/
searle.html).

Compilacoes de Producao Automatizada Utilizando Ant

Vocé pode utilizar Ant com o WebSphere Application Server - Express para
automatizar as compila¢des de producdo. Ha um artigo em varias partes, que
explica os seguintes itens:

* O que é Ant
¢ Como executar Ant dentro e fora do WebSphere Application Server - Express

e Como utilizar Ant para construgdes de produgao de elementos do J2EE (E]Bs,
WARs, EARs e assim por diante)

* Como estender Ant com novas tarefas de compilacdo do WebSphere Application
Server - Express

Consulte o artigo do WebSphere Developer Domain {Utilizando Ant com o
[WebSphere Studio Application Developer]’
(www.ibm.com/websphere/developer/library/techarticles/0203_searle/
searlel.html).
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Capitulo 10. Exemplos de Migracao

Este capitulo contém exemplos de migracdo, para ajudé-lo a aprender mais sobre
como migrar do VisualAge para Java e do WebSphere Studio "Classic” para o
WebSphere Application Server - Express IBM WebSphere Studio Site Developer.

* Exemplo de JSP/servlet do VisualAge para Java (LeapYear)
* Exemplo do aplicativo WebSphere Studio "Classic” Web (YourCo)

Exemplo: VisualAge para Java JSP/Amostra de Servlet (LeapYear)

Descricao

Este é o exemplo FindTheLeapYears fornecido com o VisualAge para Java Versao
4.0. Informagdes sobre ele podem ser localizadas na ajuda on-line do VisualAge
para Java (Samples > JSP/Servlet Development Environment).

Visao Geral sobre Migracao
Siga as etapas abaixo para migrar o exemplo do VisualAge para Java para o IBM

WebSphere Studio Site Developer. Estas etapas sdo discutidas mais detalhadamente
abaixo:

1. [Exportando seus Arquivos Java e Arquivos de Recursos do Projeto do|
VisualAge para Javal
2. |Crie um novo projeto Web do IBM WebSphere Studio Site Developer]

3. [Importe os arquivos Java e de recursos do projeto para o projeto do IBM|
WebSphere Studio Site Developerf

4. |Definindo Servlets e Fazendo Alteracdes de Reestruturacio do Aplicativol
5. [Crie um projeto do servidor do IBM WebSphere Studio Site Developer]
6. [Testando o Aplicativo YourCo Migrado}

Exportando Arquivos do VisualAge para Java
1. Abra o VisualAge para Java.
2. Selecione o projeto IBM JSP Examples.

3. Clique com o botdo direito do mouse no projeto e selecione Export. Selecione
o botdo de opg¢des Directory e clique em Next.

4. Digite o nome do diretério para o qual deseja exportar os arquivos.

5. Limpe a caixa de opgdes .class. Ndo é necessario exportar e recriar esses
arquivos a medida que vocé recompila o projeto do WebSphere Application
Server - Express.

6. Marque a caixa de opgdes .java e clique em Details. Selecione apenas os
arquivos LeapYear e clique em OK.

7. Marque a caixa de opgdes resource e clique em Details.

8. Selecione LeapYearInput.html e LeapYearResults.jsp, localizados no seguinte
diretério: IBM WebSphere Test
Environment\hosts\default_host\default_app\web\JSP\sample3.

9. Clique em OK.

10. Limpe a caixa de opgdes Create Manifest file (ndo é necessario criar um
arquivo manifest).
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11. Clique em Finish.

12. Feche o VisualAge para Java.

Criando um Novo Projeto Web do IBM WebSphere Studio Site
Developer

1.
2.

6.
7.

Inicie o IBM WebSphere Studio Site Developer.

Crie um novo projeto Web (File > New > Project > Web > WebProject)
chamado LeapYear.

Assegure-se de que Dynamic Web project esteja selecionado e, em seguida,
clique em Next.

Selecione New.

Altere o Enterprise Application project name para LeapYearEAR e selecione
J2EE level 1.2. Vocé podera colocar o projeto da Web em um projeto EAR
(Enterprise Application) existente, mas neste exemplo, coloque-o em
LeapYearEAR.

Deixe LeapYear no campo Context root.
Clique em Finish.

Importando os Arquivos Java e de Recursos do Projeto para o
Projeto do IBM WebSphere Studio Site Developer

Importe os arquivos de origem Java para o diretério de origem do projeto
LeapYear executando as etapas a seguir:

1.
2.

Na perspectiva Web, expanda LeapYear e selecione o diretério JavaSource.

Clique em File > Import > File system e clique em Next. Va até o diretorio
para o qual exportou seus arquivos e clique em OK.

E desejado importar os arquivos de origem Java apenas para o diretdrio
JavaSource, sendo assim, no didlogo Import, expanda seu diretério de
exportacao e selecione somente o subdiretério com (ele contém os trés arquivos
de origem Java).

Clique em Finish. Isso cria arquivos
LeapYear\JavaSource\com\ibm\ivj\wte\samples\leapyear\
LeapYearXXXX java. As classes Java sdo compiladas automaticamente em
Leap Year\WebContent\WEB-INF\classes.

Importe os arquivos de recursos para o projeto LeapYear no diretério WebContent,
executando as seguintes etapas:

1.

4.

Na perspectiva Web atual, expanda o projeto LeapYear e selecione o diretério
WebContent.

Selecione File > Import > File system e clique em Next. Procure o diretdrio
para o qual exportou seus arquivos, expanda seu diretério de exportagdo para o
subdiretério sample3, em seguida, clique em OK.

E desejado importar apenas os arquivos de recursos para o diretério
WebContent, sendo assim, no didlogo Import, selecione o subdiretério sample3,
o qual contém os arquivos .jsp e .html.

Clique em Finish. Os arquivos sdo importados para o diretério WebContent.
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Definindo Qualquer Serviet e Fazendo Qualquer Alteracao do
Aplicativo Reestruturado

1.

N o o~

E necessario, agora, criar um servlet. Selecione o projeto LeapYear e expanda-o
(Leap Year > WebContent > WEB-INF) para o arquivo web.xml. Abra o
arquivo web.xml.

Clique na guia Servlets, na parte inferior da pégina.

Clique em Add.

Assegure-se de que o botdo de opgdes Servlet esteja selecionado.
Selecione a classe LeapYear e clique em OK.

Selecione URL Mapping > Add, em seguida, digite LeapYear.

Salve as alteragdes (File > Save web.xml) e feche o arquivo web.xml.

Agora é necesséario fazer todas as alteragdes de aplicativos devido as pequenas
alteracoes na estrutura origem/aplicativo:

1.

7.

Havera dois erros listados na exibi¢do Tasks. Um esta em LeapYearInput.html e
outro em LeapYearResults.jsp.

Abra o arquivo LeapYearResults.jsp. Substitua /JSP/index.html por
LeapYearInput.html.

Abra o arquivo LeapYearInput.html. Substitua
/servlet/com.ibm.ivj.wte.samples.leapyear.LeapYear por LeapYear.
Salve suas alteragoes e feche os arquivos LeapYearResults.jsp e
LeapYearInput.html.

Para evitar um erro de tempo de execucdo, abra o arquivo LeapYear.java, que
estd localizado no subdiretério
JavaSource\com\ibm\ivj\wte\samples\leapyeay:

V4 para a linha 118 e altere getRequestDispatcher de
“/JSP/Sample3/LeapYearResults.jsp” para "LeapYearResults.jsp"

Salve suas alteragoes e feche LeapYearjava.

Neste momento, a amostra foi migrada para o IBM WebSphere Studio Site
Developer. Resta apenas criar um projeto de servidor do IBM WebSphere Studio
Site Developer e testar a amostra no ambiente de teste do WebSphere.

Criando um Projeto do Servidor do IBM WebSphere Studio
Site Developer

1.

Clique em File > New > Project > Server > Server Project. Clique em Next. No
campo Project Name, digite newServer e clique em Finish. Vocé mudara
automaticamente para a perspectiva Server.

Clique com o botdo direito do mouse em newServer e clique em New > Server
and Server Configuration.

No campo Server name, digite WsTestEnv. No campo Sever instance type,
selecione WebSphere V4.0 Test Environment. Clique em Finish.

Agora, é necessario especificar o seu projeto EAR na configuracdo do servidor:

1.

2.

Na exibigao Server Configuration, expanda os itens do servidor e clique em
WSTestEnv.

Clique com o botdo direito do mouse nele e clique em Add > LeapYearEAR.
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Testando o Aplicativo LeapYear Migrado

1. Selecione o arquivo LeapYearInput.html.

2. Clique com o botao direito no arquivo HTML e, a partir de seu menu pop-up,
clique em Run on Server

3. Aguarde a inicializacdo do servidor. Observe a pagina Console (clique na guia
Console na exibigdo Servers) até a mensagem “Server Default Server open for
e-business” aparecer.

4. Quando um navegador se abrir, digite 2001 no campo Start Year e clique em
Submit.

5. A exibicdo Console mostra a mensagem LeapYear:init. Aguarde até aparecer a
lista de leap years e selecione WSTestEnv na exibi¢dao Servers. Clique nela com
o botdo direito do mouse e, em seguida, em Stop.

Exemplo: Aplicativo da Web do WebSphere Studio "Classic” Versao
4.0 (YourCo)(Windows)

56

Descric¢ao

Vocé deve trabalhar com o WebSphere Studio "Classic” Versdo 4.0.x para este
exemplo.

O exemplo com a qual iremos trabalhar é o YourCo. Para acessar essa amostra,
abra a ajuda on-line (Help > WebSphere Studio 4.0 > How to > Work with the
samples > Overview). Para carregar esta amostra, siga as instru¢des em Opening
the Studio Samples (para o WebSphere Application Server 4.0) e carregue
YourCo.war.

Nota: O aplicativo migrado sera executado no IBM WebSphere Studio Site
Developer, mas o IBM WebSphere Studio Site Developer ndo fornece
atualmente todos os recursos de design de paginas da Web e de
desenvolvimento do WebSphere Studio, Professional ou Advanced Editions.

Antes de Iniciar

* Certifique-se de que o aplicativo da amostra YourCo esta carregado no
WebSphere Studio "Classic”.

* Pare todas as instancias do WebSphere Application Server (para que ndo entre
em conflito com o IBM WebSphere Studio Site Developer)

Etapas de Migracdo
Para migrar esta amostra do WebSphere Studio "Classic” para o IBM WebSphere

Studio Site Developer, siga as etapas abaixo. Cada etapa é descrita mais
detalhadamente abaixo.

1. (Opcional) [Iniciando o WebSphere Studio "Classic” e Criando um Novo Estégio|
de Migracao
2. |Criando um Arquivo do Descritor de Configuracio da Web}

3. [Criando um Arquivo de Migracio|

4. (Iniciando o IBM WebSphere Studio Site Developer e Importando o Arquivo|

WAR

5. [Criando um Projeto do Servidor do IBM WebSphere Studio Site Developer]
6. [Testando o Aplicativo YourCo Migrado|
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Iniciando o WebSphere Studio "Classic” Versao 4.0 e Criando
uma Nova Etapa de Migracao

(Opcional) Normalmente, vocé criaria uma nova etapa para uma migracdo, mas
para a finalidade deste exemplo, utilize a etapa de Teste incluida no WebSphere
Studio "Classic”. Utilizando a etapa de Teste ndo havera necessidade de editar
manualmente os mapeamentos de servlet na etapa 8.

Para obter informagdes sobre como criar uma nova etapa para migracdo, consulte
"Migrando do WebSphere Studio "Classic” para o IBM WebSphere Studio Site
Developer”.

Criando um Arquivo Descritor de Configuracao da Web

1. Na exibicdo do arquivo do projeto, clique em Project > Create Web
Configuration Descriptor File e aceite o valor padrdo WEB-
INF\Tocalhost_web.xm1.

2. Selecione todos os servlets necessarios (todos os arquivos que nao sdo
nomeados xxxxBean).

3. Nao ha arquivos TDL (Tag Library Descriptor) para este exemplo.
4. Clique em Create.

Criando um Arquivo de Migracao

1. Na exibi¢do de arquivos do projeto, selecione o servidor localhost e clique em
Properties > Publishing > WebApp Web Path e digite um caminho da Web
(raiz do contexto) “newStudioSample”. (A defini¢do de um caminho da Web
sera a abordagem recomendada no produto final IBM WebSphere Studio Site
Developer).

2. Na exibicdo de arquivos do projeto, selecione Project > Create Migration file.
3. Verifique se localhost é o servidor selecionado.

4. Verifique se localhost_web.xml é o arquivo do descritor de configuracdo da
Web selecionado.

5. Clique em OK.

6. O nome padrao do arquivo JAR é X:\Studio40\projects\ YourCo\localhost jar,
em que X é o diretério de instalagdo do WebSphere Studio "Classic”.

7. Clique em Save.
8. Feche o WebSphere Studio "Classic”.

9. Renomeie o arquivo localhostjar para localhost.war.

Iniciando o IBM WebSphere Studio Site Developer e
Importando o Arquivo WAR

1. Inicie o IBM WebSphere Studio Site Developer.

2. Clique em File > Import > WAR file > Next.

Nota: E necessdria a importacao do arquivo JAR utilizando a opgéo do arquivo
WAR, sendo este ndo funcionara de forma apropriada.

3. Digite o caminho para localhost.war no campo WAR File ou clique em Browse
para pesquisa-lo.

4. No campo Web Project, selecione New e digite newStudioSample

5. No campo EAR project name, selecione New e digite newStudioSampleEAR
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6. Clique em Finish. O IBM WebSphere Studio Site Developer descompactara o
localhost.war.

7. Vocé tera muitas referéncias nao resolvidas ou arquivos de importa¢ao
ausentes. Eles aparecerdo na exibi¢do Tasks.

com.ibm.db requires databeans.jar,

com.ibm.webtools.runtime requires webtlsrn.jar,

com.ibm.ejs.ns.jndi requires ns.jar,
com.ibm.webshpere.advanced.cm.factory requires cm.jar,

. com.ibm.ejs.models.base.extensions.webappext.ServletExtensions requires
ws-base-extensions.jar

o o0 T

Para corrigir este problema, o caminho de construcdo Java do projeto da Web
deve ser modificado.

a. Clique com o botdo direito do mouse no projeto e clique em Properties >
Java Build Path.

Clique na guia Libraries. Clique em Add External JARs.

Importe os arquivos JAR a seguir: databeans.jar, webtlsrn.jar, ns.jar, cm.jar
e ws-base-extensions.jar a partir deste diretério:
MylInstall\runtimes\aes_v4\lib

d. Restardo vinte e quatro avisos. Nao é necessério traté-los.

8. Dé um clique com o botdo direito do mouse no projeto newStudioSample e
clique em Rebuild Project.

Neste momento, a amostra foi migrada para o IBM WebSphere Studio Site
Developer. Resta apenas criar um projeto de Servidor do IBM WebSphere Studio
Site Developer e testar a amostra no Ambiente de Teste do WebSphere.

Criando um Projeto do Servidor do IBM WebSphere Studio
Site Developer

1. Va para a perspectiva Server.

2. Clique em File > New > Project > Server > Server Project. Clique em Next. No
campo Project name, digite newServer e clique em Finish.

3. Na exibi¢do Navigator, clique com o botdo direito do mouse em newServer e
clique em New > Server and Server Configuration.

4. No campo Server name, digite WsTestEnv. No campo Server instance type,
selecione WebSphere V4.0 > Test Environment. Clique em Finish.

Agora, € necessario especificar o seu projeto EAR na configuracdo do servidor:
1. Na exibicdo Server Configuration, clique em Servers > WSTestEnv.

2. Clique com o botdo direito do mouse nele e clique em Add >
newStudioSampleEAR.

Nota: (Opcional) Clique com o botdo direito do mouse no projeto
newStudioSample, selecione Properties > Server Preference > Always run
on the following server, selecione WSTestEnv, em seguida, clique em
Apply > OK. (Esta etapa somente é necessaria se vocé tiver outros
servidores).

Testando o Aplicativo YourCo Migrado

1. Selecione o arquivo YourColntro.html, o qual esta localizado no seguinte
diretério em seu projeto newStudioSample: WebContent\StudioSamples
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Clique com o botdo direito do mouse em YourColntro.html, e, a partir do
menu pop-up, clique em Run on Server e, em seguida, selecione WSTestEnv.
Aguarde a inicializacdo do servidor. Observe a pagina Console (clique na guia
Console na exibicdo Servers) até a mensagem Server Default Server open for
e-business aparecer.

Se vocé ainda ndo executou essa amostra no WebSphere Studio "Classic”, tera
que configurar o banco de dados clicando em Database Configuration.

Quando abrir um navegador, role para baixo e clique em Run This Sample.
Aguarde até aparecer a pagina Welcome e clique em Employee Center.

Nota: Na primeira vez que este aplicativo for executado, serdo enviados os
seguintes erros na pagina Console: DataSource notfound.Try to
construct a new datasource name: jdbc/yourco DataSource not found.
Try to construct a new datasource name: jdbc/studio. Esses erros sdo
autocorrigiveis. Ignore-os.

Ao terminar, feche a janela do navegador e a exibicio Web Browser, no Server
Control Panel dé um clique com o botdo direito em WSTestEnv e clique em
Stop.

(Opcional) Feche o IBM WebSphere Studio Site Developer.
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Capitulo 11. Leitura Adicional

Informacoes atualizadas sobre migracdo e outros topicos estdo disponiveis em
www.ibm.com /websphere/developer/zones /studio/transition.html|

As publicagdes a seguir e as paginas da Web fornecem informagdes gerais que

podem ser tteis para trabalhar com o WebSphere Application Server - Express:

e JSR-000053 Especificacdes Java Servlet 2.3 e JavaServer Pages 1.2:
[iava.sun.com/about]Java/communityprocess/ first/jsr053 /index.html]]

* O IBM WebSphere Application Server Versdo 4 InfoCenter:
[www.ibm.com /software /webservers /appserv/doc/v40/aes/infocenter /index.html|

* WebSphere Versio 4 Application Development Handbook:
[www.redbooks.ibm.com/pubs/pdfs/redbooks/sg246134.pdf|

* Programming J2EE APIs with WebSphere Advanced.:
[www.redbooks.ibm.com/pubs /pdfs /redbooks /sg246124.pdf|

» WebSphere Application Server Versdo 3.5 a 4.x - Migration Hints & Tips:
[www7b.software.ibm.com/wsdd /library/ techarticles /0208_wright/wright.htm]

» WebSphere Studio Application Developer Service Portal:
[www.ibm.com /software /ad /studioappdev /support/|

» WebSphere Studio Application Developer FAQ Frequently Asked Questions:
[www.ibm.com /support/search.wss?rs=457&tc=SSBRLP&dc=D800)|

» WebSphere Application Server Service Portal:
[www.ibm.com /software /software / webservers /appserv /support.html|

» WebSphere Application Server FAQ Frequently Asked Questions:
[www.ibm.com /support/search.wss?rs=180&tc=SSEQTP&dc=D800|

Leituras adicionais que podem ser interessantes:

* Um artigo sobre Uso de Ant com o WebSphere Studio Application Developer
(incluindo compilacGes/exportacdes de projetos do J2EE):
[www.ibm.com /websphere/developer /library/techarticles /0203_searle/searlel.html|

¢ Um artigo sobre Otimiza¢ao de compila¢des complexas no WebSphere Studio
Application Developer:
[www.ibm.com /websphere/developer /library/techarticles /0204 _searle/searle.html|

¢ Um artigo sobre Carregamento de Classe J2EE (Médulos e caminhos da classe
do J2EE) no WebSphere Studio Application Developer:
[www.ibm.com /websphere/developer /library /techarticles /0112_deboer /deboer.html|

* Um artigo sobre desenvolvimento de JARs do utilitario J2EE (JARs Java nos
modulos J2EE) no WebSphere Studio Application Developer:
[www.ibm.com /websphere /developer/library /techarticles /0112_deboer/deboer2 html|

* Um artigo sobre suporte de equipe no WebSphere Studio Application Developer:
www.ibm.com /websphere/developer/library /techarticles/ 0108_karasiuk/ |
0108_karasiuk.html|

* Um artigo sobre Migracdo de Componentes do Enterprise Access Builder do
VisualAge para Java ao WebSphere Studio Application Developer:
|www.ibm.com/ websphere /developer /techjournal /0201_minocha/ minocha.html|

e Um artigo sobre design de aplicativos EJB utilizando o Session Facade para falar
com CMPs: [www.ibm.com /websphere / developer/library/techarticles/
[0106_brown /sessionfacades.html]
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* Um artigo sobre as Melhores Praticas do WebSphere Application Server:
[www.ibm.com /software /webservers/appserv /ws_bestpractices.pdf|

e Um artigo sobre a zona das Melhores Praticas do WebSphere:
[www.ibm.com /websphere/developer/zones/bp /|

* Pagina da Web principal do Dominio do WebSphere Developer:
[www.ibm.com /websphere/developer]

* Artigos Técnicos do Dominio do WebSphere Developer:
[www.ibm.com /websphere/developer /techjournal /|

* Informacdes sobre a familia do WebSphere Studio e os recursos e diregdes do
WebSphere Studio Application Developer:
[www.ibm.com /websphere/developer/zones /studio /transition.html|

* Tudo sobre a Familia de Ferramentas de Desenvolvimento do IBM WebSphere
Studio:
[www.ibm.com /websphere/developer /library /techarticles /0108_studio/studio_beta.html|

* Newsgroup Externo de Desenvolvedores de Aplicativos:
news:/ /news.software.ibm.com/ibm.software.websphere.studio.application-site
develoBer|
* Newsgroup externo do workBench (Eclipse):
[news: / /news.software.ibm.com /ibm.software.websphere.studio.workbenchl|

* Newsgroup externo do WebSphere Application Server:
[news:/ /news.software.ibm.com/ibm.software.websphere.application-server]|

e Um artigo sobre implementagao de um Aplicativo do J2EE do WebSphere Studio
Application Developer para o WebSphere Application Server:
[www.software.ibm.com /vad.nsf/Data/Document3584|

* Fornecedores de Gerenciamento de Configuragao de Software de Desenvolvedor
de Aplicativos (Gerenciamento de Coédigo Fonte):
[www.ibm.com /software /ad /studioappdev /partners /scm.html|

¢ Migrando aplicativos para o Desenvolvedor de Aplicativos de ferramentas de
desenvolvimento de concorrentes:
[www.ibm.com /websphere/developer /zones/studio/migration.html|

* Migrando aplicativos do VisualCafé WebLogic para o Desenvolvedor de
Aplicativos (ainda implementando no WebLogic):
[www.ibm.com /websphere/developer /library/techarticles /0209_searle/searlel.html|

* Eclipse.org: www.eclipse.org]|

* Plugin Central de Dominio do WebSphere Developer:
[www.ibm.com /websphere/developer/downloads/plugin /|

* Plug-ins do workbench Eclipse (ndo fazem parte do Eclipse.org):
[www.eclipse-workbench.com /jsp / plugins.jsp|

* Plug-ins do Eclipse (ndo fazem parte do Eclipse.org):
[plugins.2y.net/eclipse /plugins jsp|
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Avisos

Nota sobre Direitos Restritos para Usuarios do Governo dos Estados Unidos - Uso,
duplicagdo e divulgacao restritos pelo documento GSA ADP Schedule Contract
com a IBM Corp.

Estas informagdes foram desenvolvidas para produtos e servigos oferecidos nos
Estados Unidos. E possivel que a IBM nao oferega os produtos, servicos ou
recursos discutidos neste documento em outros paises. Consulte um representante
IBM local para obter informagdes sobre produtos e servicos disponiveis atualmente
em sua area. Qualquer referéncia a produtos, programas ou servicos IBM nado
significa que apenas produtos, programas ou servi¢cos IBM possam ser utilizados.
Qualquer produto, programa ou servigo funcionalmente equivalente que nao
infrinja nenhum direito de propriedade intelectual da IBM pode ser utilizado em
substituicdo a este produto, programa ou servico. Entretanto, a avaliacao e
verificacdo da operagdo de qualquer produto, programa ou servi¢co nao-IBM sio de
responsabilidade do Cliente.

A IBM pode ter patentes ou solicitagdes de patentes pendentes relativas a assuntos
tratados neste documento. O fornecimento deste documento nao garante ao Cliente
nenhum direito sobre tais patentes. Pedidos de licenca devem ser enviados, por
escrito, para:

Geréncia de Relagdes Comerciais e Industriais da IBM Brasil
Av. Pasteur, 138-146

Botafogo

Rio de Janeiro, R]

CEP 22290-240

Para pedidos de licenca relacionados a informagdes de DBCS (Conjunto de
Caracteres de Byte Duplo), entre em contato com o Departamento de Propriedade
Intelectual da IBM em seu pais ou envie pedidos de licenga, por escrito, para:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

A IBM pode utilizar ou distribuir as informacdes fornecidas da forma que julgar
apropriada sem incorrer em qualquer obrigagdo para com o Cliente.

O pardgrafo a seguir nao se aplica a nenhum pais em que tais disposi¢des nao
estejam de acordo com a legislacao local: A INTERNATIONAL BUSINESS
MACHINES CORPORATION FORNECE ESTA PUBLICACAO “NO ESTADO EM
QUE SE ENCONTRA” SEM GARANTIA DE NENHUM TIPO, SEJA EXPRESSA
OU IMPLICITA, INCLUINDO, MAS NAO SE LIMITANDO AS GARANTIAS
IMPLICITAS OU CONDICOES DE NAO-VIOLACAO, MERCADO OU
ADEQUACAO A UM DETERMINADO PROPOSITO. Alguns paises ndo permitem
a exclusdo de garantias expressas ou implicitas em certas transagdes; portanto, essa
disposicdo pode ndo se aplicar ao Cliente.

Estas informagdes podem conter imprecisdes técnicas ou erros tipograficos.
Periodicamente sdo feitas alteragdes nas informacgdes aqui contidas; tais alteracdes
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serdo incorporadas em futuras edi¢des desta publicacdo. A IBM pode, a qualquer
momento, aperfeicoar e/ou alterar os produtos e/ou programas descritos nesta
publicagdo, sem aviso prévio

Licenciados deste programa que desejam obter informagdes sobre este assunto com
objetivo de permitir: (i) a troca de informagdes entre programas criados
independentemente e outros programas (incluindo este) e (ii) a utilizagdo mttua
das informagdes trocadas, devem entrar em contato com:

Geréncia de Relacdes Comerciais e Industriais da IBM Brasil
Av. Pasteur, 138/146

Botafogo

Rio de Janeiro, R]

CEP 22290-240

Tais informagdes podem estar disponiveis, sujeitas a termos e condigdes
apropriados, incluindo em alguns casos, o pagamento de uma taxa.

O programa licenciado descrito neste documento e todo o material licenciado
disponivel para ele sdo fornecidos pela IBM em conformidade com os termos do
Contrato com o Cliente IBM, Contrato de Licenca de Programa Internacional IBM
ou qualquer outro contrato equivalente.

As informacdes relativas a produtos ndo-IBM foram obtidas junto aos fornecedores
dos respectivos produtos, de seus antincios publicados ou de outras fontes
disponiveis publicamente. A IBM nao testou estes produtos e ndo pode confirmar a
precisdo de seu desempenho, compatibilidade nem qualquer outra reivindicagdo
relacionada a produtos ndo-IBM. Davidas sobre os recursos de produtos nao-IBM
devem ser encaminhadas diretamente a seus fornecedores.

Referéncias nestas informagdes a Web sites ndo-IBM sdo fornecidas apenas por
conveniéncia e ndo representam de forma alguma um endosso a estes Web sites.
Os materiais contidos nestes Web sites ndo fazem parte dos materiais deste
produto IBM e a utilizagdo desses Web sites é de inteira responsabilidade do
Cliente.

Estas informagoes contém exemplos de dados e relatdrios utilizados nas operagdes
diarias de negdécios. Para ilustra-los da forma mais completa possivel, os exemplos
podem incluir nomes de individuos, empresas, marcas e produtos. Todos estes
nomes sao ficticios e qualquer semelhanga com nomes e enderegos utilizados por
uma empresa real é mera coincidéncia.

LICENCA DE COPYRIGHT:

Estas informagdes contém exemplos de programas aplicativos no idioma de
origem, ilustrando as técnicas de programacdo em diversas plataformas
operacionais. Vocé pode copiar, modificar e distribuir estes exemplos de programas
sem a necessidade de pagar a IBM, com objetivos de desenvolvimento, utilizagao,
marketing ou distribuicdo de programas aplicativos em conformidade com a
interface de programacao do aplicativo para a plataforma operacional para a qual
os programas de exemplo sdo criados. Esses exemplos ndo foram testados
completamente em todas as condi¢des. Portanto, a IBM nao pode garantir ou
implicar a confiabilidade, manuteng¢do ou fungdo desses programas. Vocé pode
copiar, modificar e distribuir estes exemplos de programas de qualquer maneira
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sem pagamento a IBM, com objetivos de desenvolvimento, utilizagdo, marketing
ou distribui¢do de programas aplicativos em conformidade com interfaces de
programacao de aplicativos da IBM.

Cada copia ou parte desses programas de exemplo ou qualquer trabalho derivado,
deve incluir um aviso de copyright com os dizeres:

(C) (nome da empresa) (ano). Partes deste c6digo sdo derivadas dos Programas de
Exemplo IBM Corp. (C) Copyright IBM Corp. 2000, 2003. Todos os direitos
reservados.

Informacoes sobre Interface de Programacao

As informagoes sobre interface de programagdo destinam-se a ajuda-lo a criar
software aplicativo utilizando este programa.

Interfaces de programacdo de uso geral permitem desenvolver o software
aplicativo que obtém os servigos das ferramentas desse programa.

No entanto, essas informagdes também podem conter informagoes sobre
diagndsticos, modificagdes e ajustes. As informagdes sobre diagnésticos,
modificagdes e ajustes sdo fornecidas para ajuda-lo a depurar o software aplicativo.

Aviso: Nao utilize estas informagdes sobre diagnoésticos, modificagdes e ajustes
como uma interface de programacdo porque estdo sujeitas a alteragdes.

Marcas Comerciais e Marcas de Servico

Os termos a seguir sdo marcas comerciais ou marcas registradas da International
Business Machines Corporation nos Estados Unidos e/ou em outros paises:

o AIX

* CICS

* Cloudscape

* DB2

* DB2 Extenders
* DB2 Universal Database
* e-business

* IBM

* iSeries

* 0S/390

* 5/390

* VisualAge

* WebSphere

* z/0S

Java e todas as marcas comerciais e os logotipos baseados em Java sdo marcas
comerciais ou marcas registradas da Sun Microsystems, Inc. nos Estados Unidos
e/ou em outros paises.

ActiveX, Microsoft, Windows, Windows NT e o logotipo Windows sdo marcas

comerciais ou marcas registradas da Microsoft Corporation nos Estados Unidos
e/ou em outros paises.
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UNIX é uma marca registrada do The Open Group.

Outros nomes de empresas, produtos ou servigos, que podem estar indicados por
asteriscos duplos (**), podem ser marcas comerciais ou marcas de servigo de
terceiros.
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